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Preface

Welcome to Oracle Sales Compensation, Release 11i.

This Implementation Guide provides information and instructions to help you work 
effectively with Oracle Sales Compensation.

This preface explains for whom this Implementation Guide is intended and 
introduces other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

■ Sales Compensation managers, analysts, and salespeople tasked with 
implementing and using Oracle Sales Compensation.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology.

This documentation is available in HTML format, and contains markup to facilitate 
access by the disabled community. Standards will continue to evolve over time, and 
Oracle Corporation is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible 
ix



to all of our customers. For additional information, visit the Oracle Accessibility 
Program web site at http://www.oracle.com/accessibility/. 

Related Documents
For more information, see the following manuals:

■ Oracle Applications, Product Update Notes, Release 11i 

■ Installing Oracle Applications, Release 11i 

■ Oracle Applications Concepts

■ Implementing CRM Applications 

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual 

■ Oracle CRM Foundation Implementation Guide 

■ Implementing Oracle CRM:ERP Functional Checklist (available on Oracle 
MetaLink)

■ Implementing Oracle CRM Functional Checklist (available on Oracle MetaLink)

■ Oracle Sales Online Technical Reference Manual

■ Oracle Sales Compensation Concepts and Procedures 

■ Oracle Applications Flexfields Guide 

■ Oracle Workflow Guide 

■ Orac;e Sales Compensation Technical Reference Manual

■ Oracle Applications System Administrator’s Guide

■ Oracle Applications Developer’s Guide

■ Oracle Application Object Library/Workflow Technical Reference Manual
x



 Implementing Oracle Sales Compensation

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle Sales Compensation Concepts and Procedures

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

Overview of Oracle Sales Compensation
Using Oracle Sales Compensation you can automate the complex task of calculating 
compensation and customize compensation to suit the unique operations of your 
organization’s sales force. 

Because sales tasks vary highly from one company to another, a compensation 
system that produces windfall sales for one company might not suit another. Oracle 
Sales Compensation calculates and assigns compensation based on functions that 
precisely mirror the operations of your sales organization. For example, you can:

■ Define the structure of a compensation transaction, or the set of information 
your sales organization needs to calculate sales compensation.
Implementing Oracle Sales Compensation 1



Navigation
You specify the data you need, and Oracle Sales Compensation then collects this 
data for you from the data sources you specify.

■ Categorize your business revenue into revenue classes that specify the types of 
revenue that warrant compensation in your organization. 

Oracle Sales Compensation assigns a revenue class to a compensation 
transaction using a set of classification conditions you define for each class. You 
can pay a salesperson for certain revenue classes but not for others because 
Oracle Sales Compensation only awards credit based on the revenue classes you 
assign to a salesperson’s compensation plan.

■ Define an unlimited number of compensation plans and assign them to 
individuals or groups of salespeople.

You can compensate many different kinds of salespeople by mixing and 
matching compensation terms when you build each plan.

■ Define how your organization tracks and pays incentive compensation.

■ Specify how your organization typically makes adjustments.

After you define precisely how your sales force operates, you generate your own 
customized version of the system from which to pay sales compensation. You can 
respond to changing sales strategies by making changes in your setup and 
regenerating the system.

Navigation
The navigator displays:

■ Icon that represents each functional area

■ Drop-down list of views relating to each functional area

■ Hierarchical list of functions that relates to the selected view

■ Nodes in each hierarchy representing each related record in the database

Choose the functional area and choose a view. Double-click a node to expand the 
hierarchy. Double-click a data node to open the functional window and display the 
selected record.

Right-click a node to perform any of the following actions:

■ Add a new item below the selected node

■ Open the selected functional window
2 Oracle Sales Compensation Implementation Guide



System Integration
■ Conduct a search

■ Copy the selected node

■ Refresh the list

This version of Oracle Sales Compensation is released on two different technology 
stacks, forms and Java Server Pages (JSP). Users must navigate between forms and 
JSP to complete certain tasks, for example, processing pay data.

System Integration 
Oracle Sales Compensation integrates with other applications in the Oracle 
e-business suite to optimize the powerful functions of the product. Interface 
programs systematically link two or more systems to each other. With Oracle Sales 
Compensation and custom interfaces, you can accomplish some of the critical tasks 
of a sales compensation process:

■ Collect sales transaction data from Oracle Receivables, Oracle Order 
Management, and other sources

■ Pay supplier contract type resources using Oracle Accounts Payable

■ Download payment data in Oracle Payroll for employee type resources

■ Using Oracle CRM Foundation Resource Manager module:

■ Maintain sales roles and compensation groups

■ Maintain salespeople information

■ Generate reports (see samples reports in the appendix of this Guide) related to 
compensation and other useful sales benchmarks

■ Use Oracle Sales Online for Income Planner and salesperson self service needs

As a customization, you can create multiple interfaces, referred to as application 
programing interfaces (APIs), to bring transactions into Oracle Sales Compensation 
and to send transactions out to other systems. Oracle Sales Compensation 
transactions can originate from a sales order, a customer billing, a customer 
payment, or other business functions. 

Overview
Oracle Sales Compensation exchanges information with other products within the 
Oracle e-business suite. Transactions, the raw material that fuels Oracle Sales 
Implementing Oracle Sales Compensation 3



System Integration
Compensation, are primarily derived from Oracle Receivables and Oracle Order 
Management. 

Oracle Receivables and Oracle Order Management provide sales transaction 
information that forms the basis for calculating sales compensation.

Examples of the types of transaction data Oracle Receivables can provide include: 

■ Invoices

■ Credit and debit memos

■ Payment postings

■ Write-off postings

■ Take-back postings, which are generated when an invoice due date goes 
beyond the set grace period. The credit for the sale is deducted from the 
salesperson’s sales credit.

■ Give-back postings which are generated when a past due invoice that has 
been deducted from the salesperson’s sales credit is paid. The salesperson 
receives the credit.

From Oracle Order Management, you can collect booked orders and adjustments to 
booked orders. In release 11i of Oracle Applications, Order Management replaces 
the Order Entry system interface for collecting order information. Oracle Sales 
Compensation, as well as all other applications in the Oracle e-business suite, must 
use the new Order Capture module to interface to Order Management.

Resource Manager is the common source for resource definition, and Oracle Sales 
Compensation ability to read Resource Manager directly eliminates the need to 
create commonly used definitions and relationships in multiple applications. Use 
Resource Manager to

■ Create Resources (salespeople)

■ Create Sales Roles (formerly known as plan type) and assign salespeople to 
them

■ Create Compensation Groups, the basis of Sales hierarchy

In addition to these traditional sources of information, release 11i of Oracle Sales 
Compensation provides two-way integration to applications such as Oracle Sales 
Online, Business Intelligence Systems (BIS), and other applications within the 
e-Business suite. Some examples of this integration include the following:

■ Oracle Sales Online provides a sales performance and compensation forecasting 
tool for sales representatives and managers, based on current compensation 
4 Oracle Sales Compensation Implementation Guide



System Integration
plans. It is also a means for monitoring sales force performance through 
self-service compensation reports, the Year-to-Date Commission Summary and 
the Quota Performance Report. Salespeople can view their compensation 
summary and break down their commissions by deal, product line, period, 
adjustments, or transactions. They can also use Sales Online to view projected 
compensation based on opportunities they enter into the system or commit to 
the forecast. 

■ Compensation information is also made available to Oracle Sales Intelligence.

Foundation Modules and Dependencies
CRM Foundation modules are those that build on code shared by applications in 
the Oracle e-Business suite. A foundation module performs the same function in 
many different applications. All foundation modules are provided when any 
e-Business application is purchased. Two foundation modules that are especially 
important to understanding Sales Compensation are Resource Manager and Order 
Capture. 

Order Management is a new module in R11i of Oracle’s e-Business suite. In the 
event that Order Management is purchased and installed, it serves as the 
mechanism by which Sales Compensation accesses Order Capture information.

Oracle Sales Online
If a manager is required to allocate Quota to his/her Directs, then this manager can 
perform the Quota allocation and Compensation Plan distribution tasks via the 
Compensation tab in Oracle Sales Online windows.

If Salespeople have access to Oracle Sales Online, they can submit their estimate of 
their own Quota and either accept or reject their Compensation Plans when the 
Plans are distributed to them by their manager via Oracle Sales Online.

Please observe the following steps so that managers and salespeople have access to 
the windows under the Compensation tab in Oracle Sales Online. 

Prerequisites
System Administrator responsibility is required.

Steps
1. In the System Administrator Navigator, select Security.

2. Expand the Security menu by double-clicking on Security.
Implementing Oracle Sales Compensation 5
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3. Double-click User.

4. Double-click Define.

5. Find the Oracle Sales Compensation responsibility name by enabling this Form 
in the Query mode. From the Menu bar, select View > Query by Example > 
Enter. (The F11 key performs the same function.)

6. Enter your User’s name in the User Name field. Start the search from the Menu 
bar by clicking View > Query by Example > Run. (Pressing the Control key and 
the F11 key together performs the same function.)

7. Under the Responsibility column, add a new responsibility by selecting either 
Sales Compensation Manager or Sales Compensation Salesrep.

8. Enter a Start Date against this new responsibility assignment and possibly an 
End Date if you wish to terminate this User’s access to the Compensation tab in 
Oracle Sales Online at a certain point in time in the future.

Planning
Planning allows both managers and salespeople to provide feedback about the 
estimated sales amount that they feel is achievable.

For full functionality see the Planning section.

Income Planner
Income Planner in OSO will work after the forecast input and output formulas are 
assigned to the Compensation Plan.

The forecast formulas must contain a calculation expression object called a forecast 
amount as part of the formula. For further explanation of Formula and Expression 
functionality, please refer to: 

Creating Formulas and 

Forming Calculation Expressions.

Steps
1. Choose Compensation Plans from the Navigator.

2. Select View by Calculation Expressions.

3. Right click mouse and select New.
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4. In the Expression Block, select your Expression fields. Forecast Amount MUST 
be one of the elements selected as part of your expression if it is to be used in 
Oracle Sales Online.

5. The output expression MUST contain Rate Table Result as the first element 
selected and Forecast Amount should appear in the expression as well. 

Guidelines
For example, a salesperson’s compensation is based on a revenue quota and the rate 
table tiers relate to achievement as a percentage of the quota. Because the forecast 
results are hypothetical figures, the forecast formula does not affect the actual 
achievement result. In this case, suppose the input forecast formula is Forecast 
amount/TARGET and the output forecast formula is Rate Table Result*Forecast 
amount. The input formula expresses the proportion of the forecast amount to the 
quota, and the output formula applies a commission rate to the forecast amount. 
The commission rate chosen depends on the salesperson’s achievements to date as 
compared to the commission rate tiers.

Oracle Resource Manager

Defining Roles
A Role may encompass one or more job descriptions and job titles. Use Roles to 
assign jobs to resources, resource groups and resource teams. Oracle Resource 
Manager is delivered with pre-defined Roles for all CRM modules. Use this 
procedure to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Roles.

The Roles window displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the 
list of values. For Sales Compensation choose Sales Compensation.

3. Select the Active box to make the Role active. Select one or more of the job title 
boxes–Manager, Member, Admin, Lead–to associate the Role to job titles.

4. Use one or more of the Job lines to describe jobs associated with the Role.
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5. Select File > Save to complete the Role definition.

Oracle Payable
Oracle Payable recognizes Salespeople for payment if they are activated as 
Suppliers through Oracle Purchasing. Please refer to Oracle Purchasing Guides.

When a Payrun has been processed (Paid status against the Payrun name), the 
Salespeople Sub-ledgers are updated to reflect the amounts paid in the appropriate 
accounts and balances.When activated, user will send payrun details to Oracle 
Payable Invoices Interface table.

The following two tables show the columns which map to the invoice interface in 
Oracle Payable:
    

AP_INVOICES_INTERFACE Populated with

INVOICE_ID AP_INVOICES_INTERFACE_S.NEXTVAL

INVOICE_NUM CNPD.COMMISSION_LINE_ID

INVOICE_DATE  CN_PAYRUNS.PAY_DATE

VENDOR_ID FND_USER.SUPPLIER_ID

VENDOR_SITE_ID PO_VENDOR_SITES.VENDOR_SITE_ID

INVOICE_AMOUNT COMMISSIONABLE_AMOUNT

INVOICE_CURRENCY_CODE FUNCTIONAL CURRENCY CODE

PAYMENT_CURRENCY_CODE REP CURRENCY CODE

SOURCE “OSC” (NEW quick code of type SOURCE)

AP_INVOICE_LINES_INTERFACE Populated with

INVOICE_ID Same value as entered for AP_INVOICES_INTERFACE

INVOICE_LINE_ID AP_INVOICE_LINES_INTERFACE_S.NEXTVAL

LINE_NUMBER CNPD.COMMISSION_LINE_ID

LINE_TYPE_LOOKUP_CODE ITEM/ TAX / MISCELLANEOUS

AMOUNT CNPD
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Setting System Profile Options
The Liability Account will also be mapped to the Oracle Payable Interface. This will 
be done using the account generator, accessible via the Ruleset Form or liability 
account information entered at the plan element or revenue class level. 

Setting System Profile Options
The table below lists the profile options which need to be set to implement Oracle 
Sales Compensation after the product has been installed, but before the system is 
ready to be used to build compensation plans, collect and process transactions, and 
pay sales compensation. The options can be set in any sequence.

To set system profile options:

1. Log in to Oracle Applications and choose the Sales Compensation Super User 
responsibility. 

2. From the System pull down menu, select System Profiles.

3. Enter the following values or choose from the List of Values:

■ Application: Oracle Sales Compensation 

■ Responsibility: Use only if the profile option you are defining is specific to a 
responsibility. 

■ User: Use only if the profile option you are defining is specific to a user.

■ Profile: OSC%.

4. Click Find.

The following table contains information about Profile Options in Sales 
Compensation, along with a description of each.

Option Description

1. OSC: Collect on 
Account Credits

Default: No

The application will collect only invoices and regular credit 
memos. If set to Yes, then the application will collect 
invoices, regular credit memos, and on account credit 
memos when running Oracle Receivable Collection.

2. OSC: Commission 
Rate Precision

Default: Null

Determines the commission rate precision. For example, 
1.035 has a precision of 3.
Implementing Oracle Sales Compensation 9



Setting System Profile Options
3. OSC: Debug Mode

Default: No

Determines whether debugging messages are written to the 
process log during execution of programs, whether 
concurrent or online. Setting Debug Mode to Yes writes 
these errors to an internal audit table.

4. OSC: Default Custom 
Flag

Default: Yes

When set to Yes, the compensation plans are customized. 
Otherwise, they are not customized.

5. OSC: Log File

Default: No

If set to Yes, debugging messages are written to a log file. 
Only enable this profile option for debugging purposes if 
there are suspected problems with the application. If 
enabled, this profile option generates log files, which can 
affect performance.

6. OSC: Log File 
Directory

Sets the directory where the log file will be stored. When 
you enter the directory path, you do not need to enter a 
slash after the name.

7. OSC: Mark Events

Default: Yes

Answer No while setting up your system. Change to Yes 
when you are ready to start collecting transactions. Every 
event such as a transaction is put into the Notify Log so 
that it will be included in the next calculation.

8. OSC: Prior 
Adjustment

Default: Yes

Allows prior adjustments. If set to No, allows all plan 
elements in a period to be calculated incrementally. Before 
setting to No, be sure that any transactions that have a 
process date earlier than the latest process date shown in 
the System Parameter window have been calculated.

9. OSC: Sleep Time in 
Seconds

Default: 180 seconds

Sets the amount of wait time in between each phase of 
calculation. The wait time gives each phase time to 
complete the current process without being queried by the 
system for a status. For high volume transactions, use the 
default setting.

10. OSC: Default 
Conversion Type

Default: Null

Select the type of currency conversion. For example, 
corporate (usually budget translation rate from Oracle GL), 
spot (daily rate from Oracle General Ledger), user 
(user-defined rate as entered through form called Period 
Rates). (Toolbar > Financial > Currency Rates)

11. OSC: Salesforce 
Planning FY

Enter planning financial year, for example 2001.

12. OSC: New Items 
Profile

Default: 5

Five news items are enabled by default for display on home 
page.

Option Description
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Lookups
Lookups enable quick selection from drop-down menus. Sales Compensation has 
100 lookups incorporated into its system to speed the process of entering data into 
forms. The lookups listed in the following table display the user name in the left 
column; the Type name is shown in full caps in the right column with the default 
selections below it. In a few cases, the selections are too vast to list, so you are 
directed to the application. You can add lookups and add values to the default lists.

To view lookups, perform the following:

Steps
1. From the Toolbar, click Systems.

13. OSC: Default Tickers 
Profile

Default: ORCL

Oracle’s share price will be shown as a default. Choose 
your own ticker symbols.

14. OSC: Scaling Factor

Default: Null

Select type of figure display. For example, in thousands will 
display 1,000,000 as 1,000 and there will be a note at the top 
of the table, "USD in thousands".

15. OSC: Salesforce 
Planning Debug 
Mode

Default: No

Determines whether input variables show on the window

16. OSC: Multi Rollup 
Path

Default: Yes

Enables rollup of sales credits through multiple paths of the 
compensation group hierarchy.

17. OSC: Currency 
Exchange Rate Date

Default: System date

Enter date for reading the exchange rate in Oracle GL.

18. OSC: Workflow 
Initial Wait Time in 
Hours

Enter number of hours before the first reminder is issued.

19. OSC: Workflow 
Reminder Frequency 
in Hours

Enter number of hours interval between each subsequent 
reminder.

20. OSC: Currency Code Select a base currency.

Option Description
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Lookups
2. Select Lookups from the drop-down menu.

The Oracle Sales Compensation Lookups window appears.

3. From the Toolbar, click View.

4. Select Query by Example > Enter.

5. Repeat step 3. Select Query by Example > Run.

The first lookup appears. 

6. Scroll through the lookups by using the up and down arrow keys or use Find in 
the View drop-down menu. 

The Oracle Sales Compensation Lookups window displays the lookups 
individually as they are currently configured. 

To edit or add values to a lookup, perform the following:

1. Follow steps 1 - 6 above.

2. For edits, click in the field you want to change and enter new data.

3. To add values, click the field in the first blank line of the table and enter the 
appropriate data.

4. The From column automatically populates with the current date and the 
Enabled check box is automatically selected. Change these as needed. 

5. Save your work.

To add a new lookup, perform the following:

Steps
1. From the Toolbar, click Systems.

2. Select Lookups from the drop-down menu.

The Oracle Sales Compensation Lookups window appears.

3. Click the Application field and select Oracle Sales Compensation from the 
drop-down list.

4. Enter a name in the Type field. Use all caps with underlines between words.

5. Enter a user name in the User Name field.

6. Enter a description in the Description field if you wish.
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7. In the table in the lower part of the window, enter one or more values that you 
want to use in the lookup. Enter a code, meaning, and description that are easy 
for users to understand. 

8. Type in effective dates or click the calendar icons to enter dates from a graphic 
calendar. Select the Enable check box if you want the lookup to be operational 
within the effective date range.

9. Save your work. 

The following table lists Sales Compensation Lookups, including a description, 
Access Level, and Seeded Values and Meanings.
Oracle Sales Compensation Lookup Code Values

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning

ACCESS_CODE Access Code E Update

View

ACTIVATE_STATUS Plan Activate Status E Created

Pushed

Updated

ADJUSTMENT_REASON Manual Adjustment Reason E AR Error (Accounts Receivable 
error)

OE Error (Order Entry error)

Other

Shared (Commission should be 
split)

ADJUST_STATUS Manual Adjustment Status E Cancelled

Posted

Reversed

Review

Trial
Implementing Oracle Sales Compensation 13
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ADJUST_STATUS Transaction Adjust Status E DEALASGN (Deal Move)

Deal Split

Frozen

Manual

MASSADJ (Move Credits)

MASSASGN (Share Credits)

Original

Reversal

SPLIT (Splits)

APPLICATION_TYPE Application Type E AR (Oracle Receivables)

CN (Oracle Commission)

GL (Oracle General Ledger)

OE (Oracle Order Entry)

RA (Oracle Revenue Accounting)

BASE_RULE Base Rule E Base Rule

BATCH_STATUS Batch Status E Posted

Unposted

CALCULATION_STATUS Calculation Status E Complete

Failed

Incomplete

Processing (In progress)

CALCULATION_TYPE Types of Calculation E Bonus

Commission

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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CALC_SUBMISSION_
OBJECT_TYPE

Calculation Submission 
Object

E Calctype (Calculation type)

Concurrent Flag (Concurrent 
Calculation)

Employee Number

Employee Type

End Date

Hierarchy Flag (Entire Hierarchy)

Intelligent Flag (Do incremental 
calculation)

Interval Type

Batch Name (Calculation 
submission batch name)

Responsibility Name (Application 
responsibility name)

Salesrep Option (Salespeople)

Start Date

User Name (Application user name)

CLASSIFICATION_
DATATYPE

Classification Datatype E ALPN (Alphanumeric)

DATE 

NUMB (Numeric)

CLASSIFICATION_STATUS Classification Status E CLS (Classified)

NEVER (Never Classified)

XCLS (Failed Classification)

CN_PROMPTS Prompt Texts used in UI E Dimension Name

EXP_NAME (Expression Name)

Formula Name

Rate Table Name

CN_SEARCH_CATEGORIES Sales Compensation Search 
Categories

U Job Title

Role

Salesrep (Salespeople)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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COLLECTION_TYPE Collection Type U CN_COLLECT_CLAWBACK 
(Clawbacks)

CN_COLLECT_CUSTOM (Custom 
Transactions)

CN_INVOICES

CN_ORDERS

CN_PAYMENTS_AND_ 
GIVEBACKS 

CN_WRITEOFFS

COLUMN_TYPE Column Type E CF (Commissions Factor)

CN (User Defined)

EF (Event Factor)

IN (System)

PF (Payment Factor) 

CP_OBJECT_TYPE Compensation Plan Objects E CP_NAME (Compensation Plan)

DESC (Description)

END_PERIOD

REV_CLS_OVERLAP (Allow 
Revenue Class Overlap)

Start Date

Start Period

Status Code 

CP_PHASE_CODE Concurrent Request Phase 
Code

E C (Complete)

I (Inactive)

P (Pending)

R (Running)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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CP_STATUS _CODE Concurrent Request Status 
Code

E A (Waiting)

B (Resuming)

C (Normal)

D (Cancelled)

E (Error)

G (Warning)

H (On Hold)

I (@Normal)

M (No Manager)

P (Scheduled)

Q (Standby)

R (@@Normal)

S (Suspended)

T (Terminating)

U (Disabled)

W (Paused)

X (Terminated)

Z (@Waiting)

CURRENCY_TYPE Currency Type used in  
reports

E Functional Currency

Salesrep Currency

DATA_TYPE Column Datatypes E Date

Long

Number

Varchar2

DISCOUNT_OPTION Discount Option E None (Not apply discount pctg)

Payment (Apply to payment factor)

Quota (Apply to quota factor)

DISTINGUISHED_
HIERARCHIES

Distinguished Hierarchies E Revenue Class

Salesrep

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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DISTRIBUTE_METHOD Method for distributing 
quota

E Equal

Even

MIN (Minimum)

DYNAMIC_PROMPT Period Processing Status 
Dynamic Prompt

E Distribute Draw

Distribute Target

Draw

Payment

Period Draw

Period Targets

Target

ELEMENT_TYPE Element Type U -1000 (Recoverable Payment)

-1001 (Nonrecoverable Payment)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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EVENT_NAME Event Name E CHANGE_CLS_HIER (Change a 
hierarchy used in classification)

CHANGE_CLS_HIER_DATE 
(Change a hierarchy date)

CHANGE_CLS_HIER_DELETE 
(Delete a hierarchy interval used in 
classification)

CHANGE_CLS_HIER_PERIOD 
(Change a hierarchy interval used in 
classification)

CHANGE_CLS_RULES(Change  
classification rules)

CHANGE_CLS_RULES_ATTR 
(Change classification rules 
attribute)

CHANGE_CLS_RULES_DATE 
(Change classification ruleset date 
range)

CHANGE_CLS_RULES_HIER 
(Change classification rules 
hierarchy)

CHANGE_CLS_RULES_REV 
(Change classification rules revenue 
class)

CHANGE_CLS_RULES_SET 
(Change classification rules set

CHANGE_COMP_PLAN (Change 
compensation plan)

CHANGE_COMP_PLAN_OVER_
LAP_FLAG (Change compensation 
plan overlap flag)

CHANGE_COMP_PLAN_PERIOD 
(Change compensation plan 
effective interval)

CHANGE_CP_ADD_MGR (Add a 
manager to a compensation group)

CHANGE_CP_ADD_SRP (Add a 
salesperson to a compensation 
group)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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EVENT NAME (continued) Event Name E CHANGE_CP_DELETE_MGR 
(Delete a manager from a 
compensation group)

CHANGE_CP_DELETE_SRP 
(Delete a salesperson from a 
compensation group)

CHANGE_CP_HIER_ADD (Add an 
edge to compensation group 
hierarchy)

CHANGE_CP_HIER_DATE 
(Change date range of a 
compensation group)

CHANGE_CP_HIER_DELETE 
(Delete an edge from a 
compensation group hierarchy)

CHANGE_CP_MGR_DATE 
(Change date range of a manager)

CHANGE_CP_SRP_DATE (Change 
date range of a salesperson)

CHANGE_DELETE_TRX (Delete 
transactions)

CHANGE_FORMULA (Change a 
formula)

CHANGE_INSERT_TRX (Insert 
new transactions)

CHANGE_PERIOD_INTERVAL_
NUMBER (Change a period’s 
interval number)

CHANGE_PLAN_ASSIGN (Change 
plan assignment

CHANGE_PLAN_ASSIGN_INS_
DEL (Insert or delete plan 
assignment)

CHANGE_PLAN_ASSIGN_
PERIOD (Change plan assignment 
effective interval)

CHANGE_QUOTA_CALC (Change 
plan element)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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EVENT_NAME (continued) Event Name E CHANGE_QUOTA_DATE (Change 
plan element date range)

CHANGE_QUOTA_PERIOD 
(Change plan element effective 
interval)

CHANGE_QUOTA_POP (Change 
plan element revenue class factors)

CHANGE_QUOTA_ROLL (Change 
plan element revenue class)

CHANGE_QUOTA_UPLIFT_DATE 
(Change -plan element uplift factors 
date range

CHANGE_RC_HIER_DATE 
(Change revenue class hierarchy 
date range)

CHANGE_RC_HIER_DELETE 
(Delete revenue class hierarchy 
effective interval)

CHANGE_RC_HIER_PERIOD 
(Change revenue class hierarchy 
effective interval)

CHANGE_RT_INS_DEL (Insert or 
delete rate tiers)

CHANGE_RT_RATES (Change rate 
table rates)

CHANGE_RT_TIERS (Change rate 
table tiers)

CHANGE_SRP_HIER (Change 
salesperson hierarchy)

CHANGE_SRP_HIER_DELETE 
(Delete salesperson hierarchy 
effective interval)

CHANGE_SRP_HIER_PERIOD 
(Change salesperson hierarchy 
effective interval)

CHANGE_SRP_QUOTA_CALC 
(Change salespersons plan element 
setting)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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EVENT_NAME (continued) Event Name E CHANGE_SRP_QUOTA_PAYEE_
DATE (Change date range of payee 
assignment)

CHANGE_SRP_QUOTA_POP 
(Change salespersons uplift factors 
or payee assignment)

CHANGE_SRP_ROLE_PLAN 
(Change role/plan or 
role/salesperson assignment)

CHANGE_SRP_ROLE_PLAN_
DATE (Change date range of 
role/plan/salesperson assignment

CHANGE_SYS_PARA_RC (Change 
revenue class hierarchy used)

CHANGE_SYS_PARA_SRP 
(Change salesperson hierarchy and 
roll up flag)

CHANGE_UPDATE_TRX (Update 
transactions)

EXPRESSION MESSAGES Messages Required for Rule 
Attribute Expressions

AND

BET (between)

GT (greater than)

IIH (is in hierarchy)

IS 

LT (less than)

NOT

OR

RES (result)

WV (with value)

FORMULA_STATUS Formula Status E Complete

Failed

Incomplete

In Progress

Invalid

Valid

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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FORMULA_TYPE Formula Type E B (Bonus)

C (Commission)

INCENTIVE_TYPE Incentive Type E Bonus

Commission

Manual

Payment

Quota

INCENTIVE_TYPES Payment Incentive Types U Bonus

Commission

PMTPLN (Payment Plan)

PMTPLN_REC (Payment Recovery)

INPUT_TOKEN Input Token E QC (Quota Category)

QSR (Quota 
Category/Sequence/Role)

RCS (Role, Compensation 
Plan/Start Date)

RP (Base Quota 
Component/Percent)

SEQ (Sequence Number)

JE_BATCH_REASON Reason for creating JE batch E BONUS

CALC (Calculation)

DRAW_BONUS (Draw Recovery 
from Bonus)

DRAW_COMM (Draw Recovery 
from Commission)

PAYMENT

PAY_ADJ (Adjust Payment)

PAY_BONUS (Payment from Bonus)

PAY_COMM (Payment from 
Commission)

PAY_DRAW (Draw Payment)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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LOAD_STATUS Load Status U Loaded

Unloaded

MAPPING_TYPE Mapping Types E COL (Collection)

EVT (Event)

SLC (Slice)

MESSAGE_TYPE Message Types E Debug

Error

TRANSLATE (Translated)

MGR_REPORT Top Bottom Performance 
Report Hierarchy Level

E 1 (Directs)

2 (Level 1 Indirects)

3 (Level 2 Indirects)

4 (Level 3 Indirects)

5 (Level 4 Indirects)

ALL

MODULE_STATUS Module Status E GENERATED (Complete)

UNSYNC (Incomplete)

MODULE_STATUS_OLD Old Module Status E DEF (Definition)

GEN (Generated)

GRQ (Generate Request)

INS (Instantiated)

IRQ (Instantiate Request)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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MODULE_TYPE Module Types E ACCGEN (Account Generation)

CALCULATION

CB (Clawback Collection Module)

CB/GB (Clawback/Giveback 
Collection Module)

CLS (Classification Module)

COL (Collection Module)

CPAPI (Compensation Plan API 
Module)

INS (Commissions Instance 
Module)

INV (Invoice Collection Module)

LOADER (Transaction Interface 
Loader)

ORD (Order Collection Module)

PEAPI (Plan Element API Module)

PMT (Payment Collections Module)

PMT/GB (Payments/Giveback 
Collection Module)

REVCLS (Revenue Classification)

RUP (Rollup Module)

SLC (Slice Module)

TRF (Transfer Module)

TRX (Commissions Transaction 
Table Module)

WO (Writeoff Collection Module)

NOTIFY_ACTION The action to be taken due 
to events caused by 
changing compensation 
group hierarchy

E Delete

Pull

Roll

ROLL_PULL (Roll and Pull)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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NOTIF_LOOKUP_TYPE Lookup used by SF 
Planning workflow process

E Accept/Reject

Approve

Customized

Distribute

Notification sent

NOT_NOTIFIED (Notification not 
sent)

Reminder 

OBJECT_STATUS Object Status E I (Invalid)

N (New)

V (Valid)

OBJECT_TYPE Object Types E COL (Column)

DBL (Database Link)

IND (Index)

PKB (Package Body)

PKS (Package Specification)

PRC (Procedure)

SEQ (Sequence)

TBL (Table)

TRG (Trigger)

ORDER Order E ASC (Ascending)

DESC (Descending)

ORGANIZATION Organization E Alliances

BOL (Business Online)

Education

ISD (Telesales)

Sales

SC (Sales Consulting)

Support

PAYGROUP_UPGRADE_TYPE Paygroup Upgrade Type E Upgrade Paygroup

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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PAYMENT_CHANGE Payment Change E Bonus

Commission

PAYMENT_INCENTIVE_
TYPE

Payment Incentive Type E All

Bonus

Commission

PAYMENT_PLAN_TYPE Payment Plan Type E MIN/MAX (Minimum/Maximum)

PAYRUN_STATUS Payrun Status E Paid

Paid with Returned Funds

Posted

Returned Funds

Unpaid

PAY_GROUP_VALIDATION_
TYPE

Pay Group Validation E END_DATE (Pay Group End Date)

Pay Group Name

PERIOD_SET_NAME (Calendar)

Period Type

START_DATE (Pay Group Start 
Date)

PAY_RUN_VALIDATION_
TYPE

Pay Run Validation E Credit Type

Employee Number

Employee Type

Pay Date

Pay Group Name

Pay Period

Pay Run Name

Role

Sales Person

PAY_STATUS Pay Status E Paid

Unpaid

PA_OBJECT_TYPE Compensation Plan 
Assignment Objects

E EMP_NUM (Employee Number)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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PERIOD_PROCESSING_
STATUS

Period Processing Status E Calculated

Classified

Clean

Populated

Rolled Up

Unclassified

PERIOD_TARGET_DIST_
RULE

Period Target Distribution 
Rule

E Equal

User Defined

PERIOD_TYPE_CODE Period Type E Period

Quarter

Year

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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P_E_OBJECT_TYPE Plan Element Objects E CALC_FORMULA_ID (Formula ID)

CALC_FORMULA_NAME 
(Formula Name)

CREDIT_TYPE

CUM_FLAG (Accumulate Flag)

DESC (Description)

DISC_OPTION (Discount Option)

DISC_RATE_TB (Discount Rate 
Table)

DISC_RATE_TB_ID (Discount Rate 
Table ID)

DRAW_AMOUT (Draw Amount)

END_DATE

END_PERIOD

END_PERIOD_ID

INCENTIVE_TYPE_CODE

INTERVAL NAME

ITD_FLAG (Interval to Date)

PACKAGE_NAME

PAYMENT_AMOUT (Payment 
Amount)

PAYMENT_FACTOR (Payment 
Uplift)

PAYMENT_TYPE

PERIOD_TYPE (Interval Type)

PE_NAME (Plan Element Name)

QUOTA_FACTOR (Quota Uplift)

RATE_TB (Rate Table)

RATE_TB_ID (Rate Table ID)

REV_CLS_ID (Revenue Class ID)

REV_CLS_NAME (Revenue Class 
Name))

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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P_E_OBJECT_TYPE 
(continued)

REV_CLS_TARGET (Revenue Class 
Target

SPLIT_FLAG

START_DATE

START_PERIOD

START_PERIOD_ID

TARGET (Quota)

TRX_GROUP (Apply Trx)

UPLIFT_END_DATE

UPLIFT_PAYMENT_FACTOR

UPLIFT_QUOTA_FACTOR

UPLIFT_START_DATE

PLAN_GENERATE_STATUS Plan Generation Status E Failed

NOT_PUSHED (Not Activated)

PUSHED (Activated)

PLAN_OBJECT_STATUS Compensation Plan Object 
Status

E Complete

Incomplete

PLAN_STATE Plan State E Active

Inactive

In Progress

PLAN_TYPE_STATUS Plan Type Status E Accepted

Approved

Generated

Issued

Locked

Pending

Rejected

Submitted

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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PMT_PLAN_VALIDATION_
TYPE

Payment Plan Validation 
Type

E Credit Type

PMT_PLAN_NAME (Payment Plan 
Name)

Start Date

POSTING_TYPE Posting Type S Expense

NON_REC (Non Recoverable)

REC (Recoverable)

TO_REC (To Recover)

PROCEDURE_TYPE Procedure Types E F (Function)

P (Procedure)

Private

Public

PROCESSING_STATUS_CODE Processing Status E Clean

PROCESS_TYPE Process Types E GEN (Generate)

INS (Instantiate)

XFR (Transfer)

QUOTA_CATEGORY Quota Category Type E Fixed

Total Quota

VAR_NON_QUOTA (Variable Non 
Quota Based)

VAR_NON_REVENUE (Variable 
Non Revenue Based)

VAR_QUOTA (Variable Quota 
Based)

QUOTA_GROUP_CODE Quota Group Code E Bonus

Quota

QUOTA_PAYMENT_TYPE Quota Payment Type E FIXED (Fixed Amount)

PAYMENT (Payment Amount 
Percentage)

TRANSACTION (Applied 
Transaction Amount Percentage)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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QUOTA_TRX_GROUP Quota Transaction Group E GROUP (Grouped by Interval)

INDIVIDUAL

QUOTA_TYPE Quota Type E Discount

Draw

External

Formula

Manual

Margin

None

REVENUE (Revenue Non Quota)

TARGET (Revenue Quota)

Unit Based Non Quota

Unit Based Quota

REPORT_SECURITY_LEVEL Report Security Level E A (Analyst)

M (Manager)

R (Salesrep)

S (Super User)

REPOSITORY_STATUS Repository Status E A (Active)

I (Inactive)

REPOSITORY_USAGE Repository Usages E A (All)

P (Collector)

S (Calculator)

RESPONSIBILITY_GROUPS Salesforce Planning 
Responsibility Groups

E CN_SF_CONTRACT_APPROVER 
(Contract Manager)

CN_SF_FINANCE_MGR (Finance 
Manager)

CN_SF_SALES_MGR (Sales 
Manager)

CN_SF_SUPER_USER (Super User)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
32 Oracle Sales Compensation Implementation Guide



Lookups
RETURN_STATUS API Return Status E E (Error)

S (Success)

U (Unexpected Error)

W (Warning)

REVENUE_TYPE Transaction Credit Type E Non Revenue

Revenue

RS_OBJECT_TYPE Rate Table Objects E COMM_AMT (Commission 
Amount)

COMM_UNIT (Commission Unit 
Code)

MAX_AMT (To Tier Maximum 
Amount)

MIN_AMT (From Tier Minimum 
Amount)

RATE_TB_NAME (Rate Table 
Name)

Tier Unit Code

RULESET_TYPE Ruleset Type E Data Flag

End Date

Module Type

Object Name

PARENT_RULE_ID (Parent Rule 
Identifier)

RULESET_ID (Ruleset Identifier)

Ruleset Name

RULE_ATTRIBUTE _ID (Rule 
Attribute Identifier)

RULE_ID (Rule Identifier)

Rule Name

Sequence Number

Start Date

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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SALESREP_OPTION Salesrep Option E ALL_REPS (All Salespeople)

REPS_IN_NOTIFY_LOG 
(Salespeople in Notify Log)

USER_SPECIFY (Salespeople 
specified by you)

SCALING_FACTOR OSC: Scaling Factor U 0 (No Scaling)

1 (in tens)

2 (in hundreds)

3 (in thousands)

4 (in tens of thousands)

5 (in hundreds of thousands

6 (in millions)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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SF_FORMULA_TEXT SF Formula Text E EXPR_RTRS_DESC (SF Planning 
Rate Result)

EXPR_RTRS_NAME (SFP Rate_
Rslt)

EXPR_RTRSXTXN_AMT-DESC (SF 
Planning Rate Result times 
Transaction Amount)

EXPR_RTRSXTXN_AMT-NAME 
(SFP Rate_Rslt*Trx_amount)

EXPR-TRX_AMT-DESC (SF 
Planning Transaction Amount)

EXPR-TRX_AMT-NAME (SFP Trx_
amount)

EXPR-TRX_AMT/QTA-DESC (SF 
Planning Transaction Amount 
divided by Quota)

EXPR-TRX_AMT/QTA-NAME 
(SFP Trx_amount/quota)

FORMU-RQAP-DESC (SF Planning 
Revenue Quota Applied Amount 
Percentage)

FORMU-RQAP-NAME (SFP RQAP 
Formula

FORMU-RQFA-DESC (SF Planning 
Revenue Quota Fixed Amount)

FORMU-RQFA-NAME (SFP RQFA 
Formula)

FORMU-UQFA-DESC (SF Unit 
Quota Fixed Amount)

FORMU-UQFA-NAME (SFP UQFA 
Formula)

RT_TBL_RESULT (Rate Table 
Result)

TARGET

TRN_AMOUNT (Transaction 
Amount)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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SF_FORMULA_TYPE SF Formula Type E RQAP (Revenue Based Quota 
Applied Amount Percentage)

RQFA (Revenue Based Quota Fixed 
Amount)

UQFA (Unit Based Quota Fixed 
Amount)

SRP_OBJECT_TYPE Salesrep Object Type E ALL_ROLE (All Sales Roles)

EMP_NUM (Employee Number)

End Date

PAY_GRP (Pay Group Name)

PMT_PLN (Payment Plan Name)

ROLE (Sales Role Name)

SRP_NAME (Salesperson Name)

SRP_TYPE (Salesperson Type)

Start Date

SRP_PAYEE_OBJECTS SRP Payee Assigns Objects U COMP_NAME (Compensation 
Name)

Employee Number

END_DATE (Payee End Date)

Payee Name

Payee Start Date

PE_NAME (Plan Element Name)

Role Name

Salesrep Name

START_DATE (@Payee Start Date)

TABLE_LEVEL Table Levels E D (Dimension)

H (Header Level)

I (Internal)

L (Line +)

N (None)

S (Sales Line)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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TABLE_TYPE Table Types E T (Table)

V (View)

TIMESCALE Timescale E Period

Quarter

Year

TIME_INTERVAL_TYPE Time Interval Type E PTD (Period to Date)

QTD (Quarter to Date)

YTD (Year to Date)

TOP_BOTTOM_PERF Top Bottom Performer U Bottom

Top

TRIGGERING_EVENT Triggering Event E D (Delete)

I (Insert)

U (Update)

TRX_TYPES Transaction Types E Balance Upgrade

CBK (Clawback)

CM (Credit Memo)

DEP (Deposit)

DM (Debit Memo)

GBK (Giveback)

INV (Invoice)

MAN (Manual Transaction)

ORD (Order)

PMT (Payment)

PMTPLN (Payment Plan)

PMTPLN_REC (Payment Plan 
Recovery)

RET (Order Return)

Upgrade

WO (Writeoff)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
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Setting Up Salesforce Planning Module

Prerequisite
The tables in Resource Manager must be populated with employee and job title 
information in order for the Salesforce Planning module to run. Salesforce Planning 
has views of Resource Manager tables.

Window List for Planning Module
Tab: Salesforce   Subtab: Summary

TRX_ROLLUP_METHOD Transaction Rollup Method E INV (Invoice Processing Date)

ORD (Order Processing Date)

TRX_STATUS Commission Line Status E CALC (Calculated)

CLS (Classified)

COL (Unprocessed)

NCALC (No Calculation)

OBSOLETE (Obsoleted)

PAYEE (Payeed)

POP (Populated)

ROLL (Rolled Up)

XCALC (Failed Calculation)

XCLS (Failed Classification)

XPAYEE (Failed Payee)

XPOP (Failed Population)

XROLL (Failed Rollup)

UNIT_OF_MEASURE Measurement unit E Amount

Expression

Percent

String

YES_NO Yes or No E N (No)

Y (Yes)

Sales Compensation Lookup Description
Access
Level Seeded Values and Meaning
38 Oracle Sales Compensation Implementation Guide



Setting Up Salesforce Planning Module
Salesforce Search

Salesforce Results

Salesforce Summary

Salesperson Details

Job Title Details

Sales Role Details

Salesforce Pay Element Details

Tab: Quota   Subtab: Allocate

My Compensation Groups

Quota Modeling Summary

My Quota Estimate

Assign Quota 

Compensation Plan History

Compensation Plan

Add To-Be-Hired

Salesperson Details

Tab: Quota   Subtab: Approve

Salespeople Search

Salespeople Search Found

Contract Approval

Tab: Quota Subtab: Distribute

Salespeople Search

Salespeople Found

Distribute Contract

Tab: Quota   Subtab: Activate

Salespeople Search

Salespeople Found

Compensation Plan Activate
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Tab: Reports   Subtab: Analysis

Summary Analysis Reports

Quota Model Summary

Average Quota Summary

Overassign Quota Summary

Quota Range Summary

Tab: Reports   Subtab: Validation

Summary Validation Reports

Overlay Summary

To Be Hired Report

Transitional Salespeople

Tab: Reports   Subtab: Generation

Summary of Generation Reports

Compensation Plan Generation Status

Sales Role and Compensation Plan Mapping

Tab: Setup   Subtab: Sales Roles

Sales Role Summary

Sales Role Detail

Edit Computed Component Formula

Define Quota Anchors

Tab: Setup   Subtab: Components

Quota Components

Tab: Setup   Subtab: Attainment

Attainment Schedule Summary

Define Attainment Schedule

Tab: Setup   Subtab: Job Titles

Job Title Summary

Job Title Details
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Tab: Setup   Subtab: User Access

User Summary

User Access Detail

Tab: Setup   Subtab: Plan Text

Default Contract Text

Tab: Setup   Subtab: Activate Roles

Role Activation

Quota Components
Use this window to create Components and specify their type.

Components are parts of a Compensation Plan. Examples of Fixed Pay Components 
are Salary and Car Allowance. Examples of Variable Pay Components are 
Multimedia PC Sales, Professional PC Sales and Maintenance Service.

Prerequisites 
None

Steps
1. In the Salesforce Planning application, choose Setup > Components.

2. Enter the name of the Component.

3. Enter a short description for each component.

4. Select a Component type.

5. Check the Compute Flag check box if the value of the component is to be 
derived from a formula.

6. Check the Remove check box and click Update if you want to delete a 
component. 

Guidelines
In the example, the Component names are Fixed Salary, Car Allowance, Multimedia 
PC Sales, Professional PC Sales, Total PC Sales, Maintenance Services, Total Quota.

Component types are either Fixed or Variable. If Variable, select either Quota Based 
or Non Quota Based. In the Vision example, Fixed Salary Component and Car 
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Allowance Component are both Fixed type. Multimedia PC Sales Component, 
Professional PC Sales Component and Maintenance Services Component are 
Variable Quota Based type. 

If the Quota for a Component is to be derived from using a formula, then check the 
Compute Flag box. Total PC Sales Component and Total Quota Component are 
Variable Quota Based type as well but with the Compute Flag checked. Example, 
Total PC Sales Component has the Compute Flag checked because its value is the 
sum of the values of Multimedia PC Sales Component and Professional PC Sales 
Component added together. Total Quota Component value is the sum of values of 
Total PC Sales Component and Maintenance Services Component.

Attainment Schedule
The Attainment Schedule is used in the Compensation Contract where earnings for 
each level of achievement are displayed. To create an Attainment Schedule, perform 
the following procedure:

Prerequisites
Salesforce Planning Administrator responsibility required.

Steps
1. Click Setup > Attainment.

The Attainment Schedule Summary page appears.

2. Enter the name of the attainment schedule you want to create in the blank field 
in the Attain Schedule Name column.

3. Click Update.

4. Click the new name from the Attainment Schedule Summary.

The Define Attainment Schedule page opens.

5. Enter the desired percentages in the blank fields. 

If you need more than two fields, click Update and two more blank fields will 
appear under the saved ones.

6. Repeat step 5 until your attainment Schedule is complete. 

7. Click Update to save.
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Guidelines
To delete an Attainment Schedule, checking the Remove check box and click 
Update. You cannot delete an Attainment Schedule that is already assigned to a 
role. To change the name of an Attainment Schedule, create a new schedule with the 
same percentages, assign it to the role, and remove the old schedule.

Sales Role Summary
Use this window to find a Sales Role.

A Sales Role describes a set of salespeople who share a common compensation 
structure. Examples are PC Salesperson, Education Salesperson, Consultant, and PC 
Regional Sales Manager.

Prerequisites
Sales Roles must be created through Oracle Resource Manager.

Steps
Select a Sales Role name to go to the Sales Role Detail window.

Sales Role Detail
Use this window to view and/or edit a Sales Role’s details.

Prerequisites 
Sales Roles, Components, Attainment Schedules, Rate Tables, Single dimension Rate 
Tables must be created in the Production Module.

Steps
1. On Target Earnings: enter Total Earnings if Salesperson achieves 100% of quota.

2. Club Eligible: select check box if this Role is entitled to Club participation on 
achieving Club rules.

3. Rounding factor: Used for rounding of assigned quota. For example, input 1000 
if assigned quota is to be rounded up to the nearest 1000.

4. Minimum and maximum quota: enter the range of quota figures that this Role 
should have. 

5. Input the Compensation Plan Level. For example, a street level salesperson will 
have Level 1.
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6. Select an Attainment Schedule applicable for this Role’s Compensation Plan.

7. Fixed Pay Components: select Fixed Components and enter ascending numbers 
against each Component to indicate the sequence that each Component is to 
appear in the Assign Quota and Quota From Field Salespeople windows. Enter 
the Fixed Pay Amount for each Fixed Component. (Vision example: if the Fixed 
Salary of a PC Salesperson is 50000, then enter 50000 against the Fixed Salary 
Component.

8. Variable Pay Non Computed Components: as above, select Components and 
enter sequential order of display. 

9. Variable Pay Computed Components: select Components and enter sequential 
order of display. 

10. Variable Pay Non Quota Components: select Components and enter sequential 
order of display. Also enter the earnings figure if the target is achieved.

11. Map to Compensation Plan: entering the name of the Compensation Plan here 
will enable it to appear in Production when the activation process has been run.

Guidelines
Entering the Quota range enables the Quota Range Report to be run. The minimum 
quota on the Sales Role Details window will be picked up on the Minimum Quota 
field on the Quota Modeling window when the minimum function is invoked by 
the user. 

Compensation Plan Levels are used in the Quota Model Summary and Average 
Quota Summary Reports where the Quota for each Component are totaled, for each 
level of Salespeople in the Salespeople Hierarchy for the selected parameters 
(example, Organization, Effective Date) of each Report. 

The Attainment Schedule will be used in the Compensation Contract where 
earnings for each level of achievement are displayed.

Edit Computed Component Formula
Use this window to define a formula for a Computed Formula.

Prerequisites
Components must be created.
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Steps
1. Select a Component from the list of values.

2. Enter the percentage against this selected Component. Repeat steps 1 and 2 
until all variables of the formula have been defined.

3. Click Restore to retrieve the last saved set of information.

4. Click Save to save new information.

Guidelines
The percentages entered against each Component selected will be multiplied with 
the value of each Component. The results of all multiplication will be added 
together.

Define Quota Anchors for Sales Role
Use this window to complete the definition of the rate table and quota anchor 
details for a sales role.

Prerequisites
Rate tables must be created. Rate tables must also be assigned to the component to 
which you want to apply anchor values.

Steps
1. In the Rate Schedule Detail section, enter the commission rate range for each 

tier of the Rate Table.

2. In the Quota Anchors Detail section, select Amount if entering the commission 
earnings amount for each attainment/achievement level. For Percentages, select 
percentage and enter the percentage for each attainment level (percentage of 
quota). See Guidelines for more explanation.

3. Click Restore to retrieve the last saved set of information.

4. Click Save to save new information.

Guidelines
In the example below, at 0% achievement of quota, the variable pay is zero. At 
25% of quota, the additional variable pay is 5,000. At 50% of quota achievement, 
the additional variable pay is increased to a maximum of 12,000. This means 
that the earnings in the 25-50% tier of the rate table are compensated at a higher 
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percentage than the 0-25% tier. At the 100% level of quota achievement, the 
additional variable pay is 20,000. Any achievements over 200% of quota are 
capped by entering the same value as the previous tier (no additional variable 
pay) against the highest rate tier.

 

Default Contract Text
Use this window to define the text that accompanies the Compensation Plan.

Prerequisites
Super User responsibility is required.

Steps
1. Enter the title of the Contract at the Contract Title field.

2. Enter the Eligibility Rules in the Club Qualification text box.

3. Enter the Terms & Conditions of the Compensation Plan. 

4. Enter the Approver’s details in the Approver section.

5. Click Restore to retrieve the last saved set of information.

6. Click Save to save new information.

Guidelines
The text in the Terms & Conditions text box can be made to refer to the location of 
the Terms & Conditions. Example, “I accept the Terms & Conditions as set out in the 
Company Handbook that is posted on the Notice Board or the Company Handbook 
that was issued with the Employment Contract.” This text will appear at the bottom 
of the Compensation Plan that will be generated later.

The Approver’s details will appear at the bottom of the Compensation Plan as well.

0 Amount 0.00

25 Amount 5,000

50 Amount 12,000

100 Amount 20,000

200 Amount 50,000

9999 Amount 50,000
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Job Title Summary
Use this window to find a Job Title. Click a Job Title to access the Job Title Details 
window, where you can assign Sales Role(s) to the selected Job Title.

Prerequisites
Super User responsibility is required. Resources have been set up in Oracle 
Resource Manager.

Steps
Select a Job Title by clicking its name.

Guidelines
If using Oracle Human Resources Management System, the Job Title information 
here is read from HRMS via Oracle Resource Manager. If not using HRMS, please 
refer to Oracle Resource Manager for more information.

Job Title Details
Use this window to assign Sales Role(s) to the selected Job Title.

Prerequisites
Salesforce Planning Super User responsibility is required. Resources have been set 
up in Oracle Resource Manager.

Steps
1. Under the Role column, click the list of values box to the right of the Role field.

2. Click a Role name in the pop-up box, or enter search criteria in the Name field 
and select a Role from the search results.

3. Select a Start Date and an End Date for the term of the assignment by using the 
calendar pop-up box or alternatively, input the dates manually.

4. Click Save to save new information, or if desired, click Restore to retrieve the 
last saved set of information.

User Summary
Use this window to find a User. After that, the User Access Detail window will 
allow alterations to the selected User’s access privileges.
Implementing Oracle Sales Compensation 47



Setting Up Salesforce Planning Module
Prerequisites
Super User responsibility is required.

Steps
Select a User by clicking on his/her name.

User Access Detail
Use this window to alter the selected User’s access privilege.

Prerequisites
Super User responsibility is required.

Steps
1. In the Organization column, use the drop-down menu to change the 

organization for any listed compensation group. 

2. Use the drop-down menu to select Update or View-only access for any row.

3. To remove a listing, check the Remove check box and click Update.

4. To add a new compensation group, enter the name in the blank field in the 
Compensation Group column at the bottom of the table.

5. Click Update to save new information, or if desired, or click Restore to retrieve 
the last saved information.

Email Alert Messages
Follow this procedure to customize alert messages that are emailed to salespeople. 
The messages are a method to prompt the email receiver to perform an action. 
Example, when a sales manager presses the distribute button, his directs will 
receive an email that prompts them to view and accept their compensation plan.

Prerequisites
Oracle Workflow Builder 2.5 installed.

Steps
1. Start Oracle Workflow Builder 2.5 and connect to the database by entering its 

name, user login ID and password.
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2. In the Show Items Types window, select Compensation Plan Processing in the 
panel called Hidden. Transfer Compensation Plan Processing to the panel called 
Visible by pressing on the Visible button. Press OK.

3. On Oracle Workflow Builder 2.5 main window, expand the tree to view the 
approval process points that are represented by nodes. Expand the messages 
node. There are three messages for the sales force to view:

■ Accept Compensation Plan

■ Approve Compensation Plan

■ Distribute Compensation Plan

4. Select one of the messages for editing. For example, select Accept 
Compensation Plan.

5. In the Navigator Control Properties window, select Body tab.

6. Edit the standard text message to suit user requirements.

7. Press the save icon in the toolbar.

Guidelines
Workflow Attributes are commands to fetch actual values. Example, &FORWARD_
FROM_NAME in the Body tab will enable the name of a user with Contract 
Approver responsibility to appear in the email alert. The Workflow Attributes can 
be identified as they are text expressed in capital lettering and preceded by &. It is 
advisable to edit message text around these Attributes and not to edit the Attributes 
themselves.

Workflow Background Process
Workflow background engine process needs to be scheduled so that the workflow 
notification process can run (refer to Workflow User Guide > Setup Steps > Setting 
Up Background Workflow Engines). To enable the notification process, the 
Workflow Background Process concurrent program has to be submitted from the 
Submit Request form.

In the parameters window enter the following parameters:

Item Type: Choose Compensation Plan

Processing:

Minimum Threshold: Ignore this field
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Maximum Threshold: Ignore this field

Process Deferred: Choose Yes

Process Timeout: Choose Yes.

Schedule this concurrent program to run at regular intervals. For example, if 
notifications are required to be delivered every half hour, then set the schedule at 
30-minute intervals and the Workflow Background Process will activate every 30 
minutes and process any unprocessed items.

Notification Mailer
For email notifications to be sent, submit the Notification Mailer concurrent 
program as a concurrent process or from the command line. Before this, the 
notification mailer configuration file wfmail.cfg that is provided as a part of Oracle 
Workflow will need to be modified for your installation. Please look at the 
Workflow User Guide for details on how this can be done.

Setting Up Production Module

Window List for Production Module
The following table shows the menu and topic access to the production module.

Access from Topic

Menu bar: System System Parameters

Find System Profile Values

System Profile Values

Security Profile

Find Personal Profile Names

Personal Profile Values

Oracle Sales Compensation Lookups

Descriptive Flexfield Segments

Segments Summary (new)

Segments (new)

Menu bar: Financial Set of Books
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Closing

Journaling

Average Balances

Budgetary Control

Menu bar: Financial Multiple Reporting Currencies

Accounting Calendar

Period Types

Open and Close Periods

Currencies

Period Rates

Financial Setups Interval Type

Accumulation Period

Pay Periods

Credit Types

Credit Type Conversion Factors

Menu bar:   System Tables

Columns

Dimensions

Classification

Primary Key

Collection

Source Tables

Queries 

Mapping

Actions

Reporting

Revenue Classes Revenue Class

Hierarchies Hierarchies

Access from Topic
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Details

Import (sub hierarchy)

Hierarchies: Dimension name

Classification Rules Ruleset

Rules

Rule Attribute

Build Expression

Compensation Plans Rate Table

Rate Dim en ion

Assignment

Formulas

General

Input

Rate Table

Output

Plan Element

General

Revenue Class

Formula

Rate Tables

Compensation Plans

Plan Elements

Salesperson Assigns

Sales Roles

Menu bar:    Tasks Roles

Find Resources

Selection Criterion

Resource Search Results

Access from Topic
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Resource Details

Create Resource

Resource

Default Values

Roles

Groups

Teams

Service

Interaction Center

Compensation

Receivables

Miscellaneous

Define Groups

Members

Roles

Usages

Relations

Member Details

Move Member

Member Roles

Define Teams

Members

Roles

Usages

Member Details

Member Roles

Define Sales Roles

Pay Groups

Access from Topic
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System Setup Steps
The table below summarizes the steps necessary to successfully implement Oracle 
Sales Compensation. Further information detailing the implementation procedures 
is provided in the sections following the table.

Pay Periods

Salespeople

Payment Plan

Salespeople Workbench

Salesperson (definition)

Sales Role

Compensation Plans

Payment Plans

Submit Request (Collection)

Calculation (Run)

Maintain Transactions

Basic

Advanced

Adjust or New Transaction

Move Credit

Share Credit

Deal Move

Deal Split

Commission Lines Window

Transaction History

Customer Address

User Notes

Access from Topic
54 Oracle Sales Compensation Implementation Guide



Setting Up Production Module
Step Action Description

1. Select a set of books Use System > System Parameters to select a set of books 
set up in General Ledger

2. Set up open/close 
periods

Use Financial >Open and Close Periods 

3. Activate periods Use Financial > Accumulation Periods to assign Future 
Enterable for setting up plans and salespeople, or Active to 
process transactions.

4. Copy periods from 
Oracle General 
Ledger to Oracle 
Sales Compensation

Use Financial > Pay Periods and select Active for each 
period in the general ledger you want to copy and use in 
Oracle Sales Compensation.

5. Financial > Define 
Interval Types

Define quota intervals by assigning a name, selecting a 
calendar, and assigning an interval number to each period. 
Or, optionally, use the predefined intervals provided 
(Period, Quarter, Year). 

6. Define 
responsibilities

Optional. Default responsibilities are provided. Use 
Security > Responsibility Define to create custom 
responsibilities.

7. Assign user 
responsibilities

Use Security > Responsibility > Define to set up user 
responsibilities. 

8. Define credit types Optional. Use Financial > Credit Types to define additional 
non-monetary credit types, if needed.

9. Set credit type 
conversion factors

Optional. Use Financial > Credit Type Conversions to set 
conversion factors for converting one credit type to another, 
such as to convert non-monetary credit types to your 
functional currency.

10. Set collection 
parameters, 
salesperson batch 
size, and select 
Managerial Rollup

Use System > System Parameters to set the number of 
transactions to collect per batch, the number of transactions 
to transfer from the Collector to the Calculator, and the 
number of days to allow after payment due date before 
sales credit is taken back. Set the number of salesperson 
periods in a sales compensation calculation batch. 
Optionally, select Managerial Rollup to enable the rollup of 
credits through the compensation group hierarchies.

11. Map tables for data 
collection

See Mapping.
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Defining the Calendar
To use Oracle Sales Compensation you must define the calendar and set of books on 
which you want to base your compensation periods. If you have already defined 
these in Oracle General Ledger, you need to identify this information in Oracle Sales 
Compensation. 

Define the set of books in Oracle General Ledger (GL) using these forms:
Set of Books 

Calendar 

Period Types 

Open and Close Periods 

Key Flexfields

Select the set of books in Oracle Sales Compensation
A set of books identifies a company or fund within Oracle Applications that shares 
a common chart of accounts, structure, calendar, and functional currency. Oracle 
Sales Compensation processes sales compensation payments according to periods 
defined in a calendar associated with a set of books you define in Oracle General 
Ledger (see Oracle General Ledger Reference). 

12. Set rule batch size 
parameter in System 
> System Parameters

The Rule Batch Size parameter is used by the code 
generation program to determine how many PL/SQL 
packages should be created for a revenue classification. 
This parameter needs to be set because the PL/SQL 
compiler limits the size of the PL/SQL blocks and gives a 
"program too large" compilation error when this limit is 
exceeded.

13. Create manual 
transaction reason 
codes

Optional. If you want reason codes identified for manual 
transactions, then set them up in the ADJUSTMENT_
REASON lookup table. Use System > Lookups. See the 
Oracle Application Object Library Reference Manual.

14. System > Security 
Profile

Optional. If you want to grant a manager security access to 
compensation information for salespeople not included in 
normal security for the manager, then set up the 
relationship using this window, if needed.

Step Action Description
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Prerequisites
None

Steps
1. Navigate to the system Parameters window, or by default choose System 

Parameters from the Setup menu.

2. Enter a name for your Oracle Sales Compensation instance.

3. In the Set of Books field, choose a GL set of books from the list of values, which 
Oracle Sales Compensation obtains from all sets of books you have defined.

You will then see displayed this information obtained from the GL books:

■ Calendar associated with this set of GL books (view only, cannot be edited)

■ Period Type associated with this set of GL books (view only)

■ Currency associated with this set of books

4. Define the Collector Set of Books. You must be in the collector instance, and 
from the System parameters window pick the same set of books as you are 
using in your Oracle Receivables source. 

Open and close periods in Oracle Sales Compensation
To administer Sales Compensation periods, set up your periods to the Future 
Enterable state. When you are ready to calculate the sales compensation payments, 
open the appropriate accounting period. You may close an accounting period after 
you have calculated and paid the compensation, or you may leave multiple periods 
open if you expect to make adjustments for prior periods.

Oracle Sales Compensation uses period information for these functions:

■ Compensation plans and plan elements

■ Compensation plan assignments

■ Period targets

■ Payment Plans

■ Hierarchies

■ Salesperson rollup structure

■ Adjustments to sales credits

■ Account adjustments to subledger account balances
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■ Employment start and end dates

Steps
1. To change period status, navigate to the Periods window, or by default, choose 

Periods from the Administration menu.

Oracle Sales Compensation displays the following period information:

■ For System Status: INACTIVE (never opened) or ACTIVE (permanent 
status after a period has been opened)

■ Name, Year, Quarter, Start Date, End Date 

■ Default value for Period Status is Never Opened, but it can change to:

Open, Closed, Permanently Closed, Future-Entry

■ Status Code for salespeople for the period: unclassified (no activity or not 
yet recalculated after changes), classified (one or more salespeople failed 
the population process), populated, calculated.

Note: Changing a revenue class, salespeople, or classification rules 
hierarchy or a compensation plan automatically changes the period Status 
Code to Unclassified and you must recalculate the period.

2. Select the period and then choose a period status: Future Enterable, Open, Close 
Permanently, Close

When changing the period status you can change a Never Opened period to 
Future Enterable and then to Open. You can close an Open period and open a 
Closed period.

You cannot change a Permanently Closed period.

Note: once you permanently close a period, you cannot reopen it and no 
transactions of any kind can be processed. Be sure that there are no new 
transactions, adjustments, takebacks, payments, or any other outstanding 
transactions before you permanently close a period.

Setting Up Collections
Two major processes are required to compute sales compensation: data collection 
and compensation calculation. 

As a data collector, Oracle Sales Compensation provides the means to collect data 
from Oracle Receivables, Oracle Order Capture, or other data sources and to 
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prepare that data to be transferred to the Oracle Sales Compensation calculation 
processes. 

Collecting Transaction Data 
To collect transaction data, specify the transfer batch size in the System Parameters 
form. A typical collection batch size is 2000 transactions, but that depends on your 
system.

Setting Up A New Transaction Source
For each Transaction Source there are three pieces of information:

■ Name: user-defined and changeable, and may include legacy sources.

■ Type: the short-name of the Transaction Source. User-defined, must be unique 
and cannot be changed.

■ Status: Complete/Incomplete. This indicates whether the Collection package 
has been generated for the Transaction Source since the latest setup changes 
were made.

The Tables window contains five tabs: Source Tables, Queries, Mapping, Actions, 
Reporting. Use these tabs as described here. 

Source Tables
This tab is used to specify all tables that are used during the creation of 
compensation transactions, that is, the Direct Mapping tables. Supply the required 
information in each field.

■ A Line table is mandatory. It contains the line items against which 
compensation is to be paid. L_ORDER_LINES has been designated as the Line 
table. 

■ The Key Column is mandatory: it is the field in the table that uniquely identifies 
each line. 

■ Specify any additional tables to be used in creating compensation transactions 
in the Extra Direct Tables List.

■ Optional Header Table area, in which the L_ORDER_HEADERS table has been 
specified. (The reason for this will be explained under the Queries tab.) If you 
specify a Header Table, also specify a Key Column for it and in the Line Table 
Header Identifier specify the field in the line record (foreign key) which allows 
it to be joined to the Key Column of the Header Table.
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Guidelines
Before using any table, be sure that table is registered using the Tables form (below). 
Table aliases are system-defined. These are the values that you must use if you refer 
to a table by its alias.

The Tables and Columns form requires the table name, user name, alias (which is 
automatically generated), and description, and whether it is to be used in a 
calculation.

For the Columns tab you must supply user column name, indicate data and type 
length. 

Queries
Within this tab the significance of the information entered in the Source Tables tab 
becomes apparent. The capability for querying depends on the information entered 
into the Source Tables. You can generate a list of transactions that are eligible for 
compensation using the Notification Query and Parameters.

Notification Query 
This query joins together the mandatory Line table (L_ORDER_LINES) and the 
optional Header table (L_ORDER_HEADERS). It is necessary to specify a header 
table, even though the purpose of Notification is to get a list of identifiers from the 
Line table. The reason for this lies in the additional criterion which has been added 
to the end of the WHERE clause:

AND loh10000.booked_date BETWEEN p_start_date AND p_end_date

This restriction means that the user wants to collect only the orders that were 
booked between a specific start and end dates. The booked date of the order resides 
in the Order Header, so it is necessary to bring the L_ORDER_HEADERS table into 
the Notification Query to allow this. This requirement often applies, so the Header 
Table field on the Source Tables is provided to enable this match without the need 
for advanced SQL knowledge.

P_start_date and p_end_date are parameters whose values are set by the user before 
collections is run for this Transaction Source. Although the parameters must be 
registered on this tab, their runtime values are set on a different form (Setup -> 
Collection Parameters menu option). A separate form is used because for any changes 
made on the Collections form to take effect, it is necessary to regenerate the 
collections package, whereas the parameter values can be changed without needing 
to regenerate.
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Collection Query
The list of tables in the Collection query FROM clause (the Direct Mapping Tables) 
consists of the Line table, the (optional) Header table and all of the tables listed as 
Extra Direct Tables on the Source tables tab.

The WHERE clause of the query already contains the necessary join information to 
get the right rows from the Line and Header tables. The user is required to complete 
the WHERE clause with all the join information necessary to get the right rows from 
the Extra Direct tables.

Once the information on the Queries tab is entered, you have completed all the 
setup necessary to build a correct set of compensation transactions from the source 
tables in your legacy system. The next step is to define what information will 
actually be stored in the compensation transaction. That is the function of the 
Mapping tab.

Mapping
Use the Mapping tab to specify what data is needed to fill each destination column 
when a compensation record is collected from the Transaction Source.

When you move to the Mapping tab for the first time after creating a new 
Transaction Source, you will see that the Source/Destination list on this tab has 
been pre-populated with a number of records. These records are the mappings for 
the mandatory Destination Columns, those columns in CN_COMM_LINES_API 
that must always be filled before a CN_COMM_LINES_API record can be imported 
into Oracle Sales Compensation. Examples of mandatory columns are Employee_
Number, Transaction_Amount, Transaction_Type and Source_Doc_Type. You 
cannot delete these mandatory mappings.

In some cases the Source Field for the mapping, that is, the description of the data 
used to fill the Destination Column, has been pre-populated and cannot be updated. 
An example of this is the mapping for Source_Doc_Type, which is set to be the Type 
that you enter when you name the Transaction Source (‘LEG’ in our example). Most 
Source fields are left blank though and you have to define the source data for these 
mappings. You can not generate a Collection package if any mapping has a blank 
Source (although you can enter the value NULL in the Source field if you need to).

The Source field can contain a simple column specification or any other valid SQL 
expression. Each of the following is potentially a valid Source value:

NULL  NULL value
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Direct and Indirect Mappings are set up differently. A description of each follows.

Direct Mappings
Direct Mappings are those where the source data is derived exclusively from one or 
more tables in the FROM clause of the Collection Query (any table listed on the 
Source Tables tab). 

If the Source data does not include any database information at all--if it is just 
NULL or a literal value --then this can also be regarded as a Direct Mapping.

To define a Direct Mapping, type the appropriate SQL expression into the Source 
field. A Direct Mapping is simply incorporated into the Collection Creation query 
that was described earlier. This single SQL statement already knows how to join all 
of the Direct Mapping tables together, so you need to define only what column 
information (if any) you need from these tables.

Notice that all seven of the example expressions above refer either to no table data 
at all, or only to columns from one of our Direct Mapping tables. These are therefore 
valid Direct mappings in the context of our example setup. Suppose for example 
that for the Quantity Destination Column, you want to use NVL(lol10001.ordered_
quantity, 0) as the Source value. All you would need to do is type exactly this text 
into the Source field for that mapping.

Although you can type this text directly into the Source field, this approach is 
potentially error-prone. You need to spell the column name (ordered_quantity) 
correctly and you should normally precede that with either the full name of the 
source table (l_order_lines) or the exact alias of the table (lol10001). Instead of this 
manual procedure, you can press the Source Builder button to get a List Of Values 
(LOV) to help you. 

 The required Source field text, for example, can be created as follows:

1. Type NVL(in the Expression field.

’My Text’  literal value

booked_date  column_name

l_order_headers.booked_date  table_name.column_name

loh10000.booked_date  table_alias.column_name

NVL(lol10001.ordered_quantity, 0)  SQL function

my_function(loh10000.booked_
date,lsc10002.salesrep_id)

 user function
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2. Click the Table Name LOV. The names of the Direct Tables are listed.

3. Select L_ORDER_LINES.

4. Click the Table Name LOV. The names of the L_ORDER_LINES columns are 
listed.

5. Select ORDERED_QUANTITY

6. The text lsc.amount is appended to the expression field

7. Type, 0) at the end of the Expression field

8. Click Apply. The dialog disappears and the full expression is now pasted into 
the Source field.

Alternatively, you can use Source Builder to paste the lol10001.ordered_quantity 
text into the Source field and then build the rest of the expression up in the Source 
field itself.

Indirect Mappings 
They are implemented as UPDATES to the existing CN_COMM_LINES_API record 
you need to define the FROM and WHERE clauses of this UPDATE statement. 
There are two ways that this definition is performed, the Free-Form Indirect 
Mapping and the Relationship Indirect Mapping.

With a Free-Form mapping you must type in the exact FROM/WHERE clause 
manually on the Mapping tab. With a Relationship Mapping you first use the 
External Tables form to define a join relationship between CN_COMM_LINES_API 
and the table from which the source data is to be collected. Then on the Mapping 
tab you specify this join relationship in the Relationship field. The FROM/WHERE 
field then becomes read-only and is automatically set according to that Relationship 
definition.

In the example in the Concepts section, we wanted to store the salesperson territory 
in the Attribute1 field of CN_COMM_LINES_API. The territory can be taken from 
L_TERRITORIES, using the Salesrep_ID, which is also present in the L_SALES_
CREDITS table.

The first requirement to implement this is to set up a Direct Mapping which stores 
the Salesrep_Id from L_SALES_CREDITS. Set up the Direct Mapping as follows:

1. Create a new record in the mappings list.

2. Enter lsc.salesrep_id in the Source Field.
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3. In the Destination field select a spare column, like Attribute99, from the LOV 
DO NOT use the Salesrep_ID destination column: the reason why is explained 
later in Mapping the Employee Number.

A Free-Form Indirect Mapping for Territory can be set up as follows:

1. Create a new record in the mappings list.

2. Enter FROM l_territories lte WHERE lte.salesrep_id = api.attribute99 in the 
FROM/WHERE field.

3. Enter lte.territory_name in the Source field. Note that if you use Source Builder 
to do this, the Table Name LOV will list all of the tables that are currently 
registered (in Tables & Columns) in Oracle Sales Compensation. This is because 
the FROM clause is free-form text which could contain multiple tables. It is 
easier to list all the tables for the user to choose from than to try to extract table 
names out of the FROM/WHERE clause.

4. In the Destination field select Attribute1 from the LOV.

Alternatively, a Relationship Indirect Mapping for Territory can be set up as 
follows:

1. Use the External Tables form to set up a join relationship. In this relationship the 
Source Table is L_TERRITORIES and the Destination Table is CN_COMM_
LINES_API. The Source Column is Salesrep_id and the Destination Column is 
Attribute99.

2. Go back to the Mappings table of the Collections form. Create a new record in 
the mappings list.

3. Use the LOV on the Relationship field to select the relationship that you have 
just set up. The FROM/WHERE clause is now automatically populated.

4. Enter lte.territory_name in the Source field. Note that if you use Source Builder 
to do this, the Table Name LOV will list only L_TERRITORIES because this is 
the source table for your chosen relationship.

5. In the Destination field select Attribute1 from the LOV.

Whether you set this up as a Free-Form or a Relationship mapping, you will see that 
the following text is displayed beneath the Relationship field:

UPDATE cn_comm_lines_api api SET attribute1 = SELECT lte.territory_name

The FROM/WHERE field completes the statement:

FROM l_territories lte WHERE lte.salesrep_id = api.attribute99
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This shows you in SQL terms exactly how your Indirect Mapping will be physically 
implemented. If you look back to the screen shot at the start of the Mapping section, 
you will see that it shows the use of a Free-Form Indirect Mapping to populate 
Attribute1.

Indirect Mappings: Free-Form or Relationship. When should you use a Free-From 
Indirect mapping and when should you used a Relationship mapping?

The Relationship Mapping is more restrictive than the Free-Form version. On the 
External Tables form you can only define simple equivalence joins between tables, 
which means joins of the form:

WHERE table1.columnA = table2.columnB

      AND table1.columnC = table2.columnD

This rules out the use of other tests such as OR, BETWEEN, <, != and so on as well 
as the use of functions such as NVL and the outer join operator.

A relationship also only allows you to join to a single Indirect table. If you need to 
join multiple tables together then you cannot use the Relationship option, unless 
you create a custom view to hide the join.

In the cases described above, the Free-Form mapping is therefore the one to choose.

There is no occasion where you actually have to choose a Relationship mapping 
over a Free-Form one. Relationship mappings would be chosen because of setup 
simplicity (they can be re-used in multiple mappings) and maintainability. 

Mapping the Employee Number. The salespeople used by Oracle Sales 
Compensation are set up using Oracle Resource Manager. When you define 
resources in Oracle Sales Compensation, you are actually using Resource Manager 
windows. The Sales Credits which are managed and calculated within Oracle Sales 
Compensation are linked to their owning salesperson using the Salesrep_ID 
allocated for the salesperson by Resource Manager.

The problem which arises when importing transactions from a legacy system is that 
the Salesperson Identifier on a legacy record will not match the Salesrep_ID for that 
person which was allocated when he/she was registered in Oracle Sales 
Compensation. The Resource Manager Salesrep_ID is an internal key which is not 
visible to the user and is also non-updateable.

A way is therefore provided to make this link between ‘Legacy’ salespeople and 
Oracle Sales Compensation salespeople. The solution is as follows:
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When creating a new Resource in Oracle Sales Compensation, one of the fields to be 
filled in is ‘Resource Number’. In this field you should record the user-visible 
unique identifier that this person has in your legacy system.

On the Mappings tab set the Source of the mandatory ‘Employee_Number’ 
mapping to be person identifier column from your legacy system.

When records are subsequently imported from CN_COMM_LINES_API into Oracle 
Sales Compensation, if the CN_COMM_LINES_API.Salesrep_ID column is 
blank, the load program will take the value in CN_COMM_LINES_API.Employee_
Number, find the individual in Resource Manager whose Resource Number is equal 
to that value and then populate CN_COMM_LINES_API.Salesrep_ID with the 
Resource Manager Salesrep_ID for that individual.

Actions
The Actions tab allows the user to change the Collection processing for their 
Transaction Source in two ways, either by specifying the Transaction Filters or by 
adding User Code Blocks. Transaction Filters are more relevant in conjunction with 
the pre-defined Transaction Sources of Receivables and Order Management, so they 
will be discussed later.

User Code Blocks are single or multiple PL/SQL statements which you can choose 
to have inserted at defined points within the Collect procedure that will be 
generated for your Transaction Source. You can insert User Code Block at three 
locations:

Pre-Notification: the beginning of the procedure

Post-Notification: between running the Notification and Collection queries

Post-Collection:   after the Collection query has been run

To create a User Code Block, choose the required Location from the selection list 
and then type your statement(s) in the Code field.

Reporting
When the preceding setup is complete, you are nearly ready to press the Generate 
button and create your Collections package. However, since pressing that button 
will replace the existing version of the package with a new one based upon the 
current setup, test first whether this new package is valid. The Reporting tab 
enables you to test the validity of the new package.
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When the Test Generate button on this tab is pressed, a test version of the Collection 
package is generated for the selected Transaction Source.

The Error Text field lists compilation errors in the generated package together with 
their line numbers. The Package Text field displays the entire code, with line 
numbers, for the package. This way, if any errors are listed for the package, you can 
easily find the offending line of code in the Package Text field.

The usual cause of a compilation error is invalid SQL which has been typed in on 
the Queries or Mappings tabs or, as in the window above, in a User code Block. It is 
easy to identify such problems on the Reporting tab, go back and fix them and then 
re-run the test generate.

Hint: when you look at the Package Text, click the field and then click the Edit Field 
icon in the toolbar. This brings up the contents of the field in a resizeable window so 
that you can see more lines and greater line width.

Apart from finding compilation errors, the other main use of this tab is to allow you 
to scan through the generated package and confirm that it is doing what you had 
intended when you set up the information on the other tabs. It enables you, for 
example, to see exactly where in the Collect procedure your User Code Block(s) will 
be executed.

Running Collections
When you are satisfied with the results of a test generation, press the Generate 
button to create the real Collection package for your Transaction Source. 

It is recommended that you actually run the package to collect transactions. This is 
accomplished by the Collect Custom Transaction Source Concurrent program. This 
program requires you to enter a single parameter, the name of your Transaction 
Source. The LOV on this parameter lists all custom Transaction Sources that have 
been set up.

Remember that if you created any parameters on your Queries tab, you do not set 
their values on the Concurrent Program run form. You have to use the Collection 
Parameters form to set their runtime values before you call up the Concurrent 
Program.

The final action required to pull these transactions from the API table into Oracle 
Sales Compensation is to run the Transaction Interface Loader concurrent program, 
or to press the Load Transactions button on the Maintain Transactions form.
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Setting Up A Standard Transaction Source
Oracle Sales Compensation is delivered with two pre-defined Transaction Sources: 
Oracle Receivables and Oracle Order Capture.

The setup of Collections for these Transaction Sources is very similar to the setup of 
new user-defined Sources. The difference is that for the Standard Transaction 
Sources you cannot make any changes to the Source Tables or Queries tabs. This is 
because collection from Receivables and Order Capture is implemented as complex 
procedural logic rather than as simple Notification and Collection queries and it is 
not possible to express that logic on the Queries tab.

Both the Standard Transaction Sources are delivered with a set of mappings to 
populate the important columns in CN_COMM_LINES_API. You are allowed to 
change Source values for these mappings and also to create new mappings of your 
own. 

When you first display the Mappings tab for a Standard Transaction Source, the 
Inherited column will display === for every mapping. This tells you that the 
mapping is a standard one and has not been changed. If you change the value in 
either the Source, Relationship or FROM/WHERE field for a standard mapping, the 
Inherited column will change to display =X=. If you want to revert a mapping to its 
original standard setup, press the Inherit button. The Source, Relationship and 
FROM/WHERE fields change back to their original values and the Inherit field 
reverts to ===.

If you create any new mappings, the Inherited column is blank for these rows and 
the Inherit button has no effect.

Using Filters
Since you cannot access the Queries tab for a Standard Transaction Source, you 
cannot change the collection query to filter transactions that you do not want. This 
is why the Filters on the Actions tab are useful for these Transaction Sources.

Filters allow you to define criteria for the removal of unwanted transactions. 
Suppose for example you do not want to compensate people for any transaction 
with a value of less that $100 (we will assume that all your sales are in dollars). You 
can specify this on the Actions tab simply by entering the text api.transaction_amount 
< 100 on a line in the Filters section of this tab. 

Alternatively you can press the Clause Builder button to help you build this 
expression. Clause builder works in the same way as the previously described 
Source Builder, except that you do not choose a table, since the filter always applies 
to a column in CN_COMM_LINES_API.
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You can also decide which method of filtering should be carried out for your 
Transaction Source, using the radio button in the Filter section. If you select Physical 
Delete then filtered transactions are physically deleted from CN_COMM_LINES_
API. If you select Mark As Filtered, the transactions are not deleted - they are 
marked as FILTERED and are never imported into Oracle Sales Compensation.

Receivables and Order Capture Special Features

Oracle Receivables
The pre-defined Receivables data source differs slightly from any other data source 
because it really represents four Transaction Sources which have been combined 
into one, so that they can share a set of Mappings. The four sources are referred to 
as Receivables Events and are as follows:

■ Invoices, Credit Memos and Debit Memos

■ Take-backs (once an invoice due date goes beyond the set grace period, the 
credit for the sale is deducted from the salesperson’s sales credit)

■ Payments and Givebacks (a Giveback is a past due invoice that had been Taken 
Back but has now been paid)

■ Write-offs

These events occur when the relevant transaction is posted to the Oracle General 
Ledger application.

The Transaction Collection Queries for these Events are all based around the same 
core set of Receivables source tables, but the tables are joined together in different 
ways so four different Transaction Sources would normally be required. The four 
have been combined into a single Transaction Source so that you set up only the 
Mappings that you want once and they are applied to the collection of 
Compensation Transactions for all four Events. 

When you press the Generate button for the Receivables Transaction Source, four 
packages will be generated, one for each Receivables Event. This generation takes 
four times as long as for any other Transaction Source. However, you may not be 
interested in all these Events. It is therefore possible to restrict the generation to 
only those packages for the Events that you require. When the Receivables 
Transaction Source is selected, a special table appears on the top-right corner of the 
window. Use this table to select Events. When the Generate button is pressed the 
full package will be generated.
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Each Receivables Event has a dedicated Concurrent Program. Each of these requires 
two parameters - a Start Period and End Period. The parameter entry is supported 
by a List Of Values. The Concurrent Programs are as follows:

■ Collect Invoices

■ Collect takebacks

■ Collect Payments And Givebacks

■ Collect Writeoffs

Oracle Order Capture
Compared with Receivables, the Order Capture Transaction Source behaves more 
like the user-defined Transaction Sources which were defined earlier.

A single Collection package, Collect Orders, is called by a dedicated Concurrent 
Program. The Concurrent Program requires two parameters, a Start Period and End 
Period. The parameter entry is supported by a List Of Values.

Although this Transaction Source collects from Order Capture, the transactions 
actually originate in the Oracle Order Management product. Order Capture just acts 
as an interface. The transactions themselves are sales credits for Orders which have 
reached the Booked status in Order Management.

Adjustments
Order information can be, and often is, changed after the Order has been set to the 
status of Booked. Such changes, known as adjustments, can be automatically 
applied to transactions which have already been Collected. If a change is made to 
any Line on an Order then all of the Sales Credits (Compensation Transactions) for 
that line are considered to be changed. There are two possible scenarios:

■ The Compensation Transactions have been Collected but have not been Loaded 
into Oracle Sales Compensation.

■ The Compensation Transactions have been Collected and also Loaded into 
Oracle Sales Compensation.

In Scenario 1, the transactions have only got as far as the CN_COMM_LINES_API 
table. In such cases the original transactions are marked OBSOLETE and they will 
be re-collected into CN_COMM_LINES_API with their new values the next time 
Collect Orders is run.
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In Scenario2, the transactions are already inside Oracle Sales Compensation and 
may have even been used to calculate salesperson commission. This requires a 
different approach. The original transactions in CN_COMM_LINES_API are 
marked FROZEN. For each of these a reversing transaction is also created in CN_
COMM_LINES_API. This is a duplicate of the FROZEN line, but with an opposite 
polarity (usually meaning it becomes negative) on the Transaction Amount. This 
transaction will have the effect of reversing out the original. Finally, as in scenario 1, 
the Compensation Transactions for this line will be re-collected into CN_COMM_
LINES_API with their new values the next time Collect Orders is run.

Each time Collect Orders is run, the list of unprocessed updated Order Lines must 
first be processed. This can take rather a long time. To avoid having a long wait 
when running Collect Orders, it is a good idea to process this list of updated Order 
Lines at regular intervals (perhaps daily). There is a Concurrent Program to do this, 
Order Update Notification.

The list of updates to Orders is maintained for Oracle Sales Compensation by the 
Order Capture application. This however only occurs if Order Capture has been 
informed of this requirement. You must register Oracle Sales Compensation with 
Order Capture as follows:

1. Switch Responsibility to Oracle Order Capture

2. Open the Lookups form

3. Display the ASO_ORDER_FEEDBACK_CRM_APPS lookup type

4. If it is not already there, create a row with Code CN, Meaning Sales 
Compensation and check the Enabled box. Save this row.

Coping With Adjustments  You can cope with adjustments to transactions in your 
custom Transaction Sources in the same way as standard Collections from Order 
Capture does. All you need to do is to call a Collections API, identifying the 
transaction that has been changed.

If you specified a Header Table on your Source Tables tab then you need to pass the 
unique identifiers of both the Header record and the Line record of the changed 
transaction. Otherwise only the identifier of the Line record is required.

Suppose that Collections has already been run for October 2000 transactions in our 
example legacy system. We have also imported those transactions into Oracle Sales 
Compensation. Now a change is made to one of the orders for that month. The ID of 
the Order Header is 1001 and the ID of the Order Line is 1234. To notify Oracle Sales 
Compensation of this change you make the following call:

CN_NOTIFICATION_PUB.Create_Notification
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The next time Collections is run for this Transaction Source, reversing transactions 
will be created to nullify all sales credits associated with this transaction line. All 
sales credits will then be collected again with the new values in. This reversal and 
re-collection of the October transaction will occur even if you specify that you want 
to collect only November transactions this time.

Note: To understand the p_org_id parameter, you need to first understand the 
Oracle Applications ‘Multi-org’ strategy, which allows data for multiple operating 
units to exist, partitioned from each other, within a single database. Discussion of 
Multi-org is beyond the scope of this document. If you do not understand this 
concept then please consult the appropriate documentation before trying to 
understand the rest of this paragraph. If your procedure which calls CN_
NOTIFICATION_PUB.Create_Notification is running in a database session where the 
Org-Id has been set, and your procedure is only dealing with transactions for this 
Org-Id, then you can omit the p_org_id parameter. In any other situation (for 
example where you have a single procedure or database trigger which detects 
updates to transactions from multiple Org-Ids) you must specify the correct value of 
p_org_id for the transaction when you call Create_Notification.

Adjusting Transactions
If a collected transaction contains errors in information or credit assignment, then it 
can be corrected with an adjustment. Use this procedure to adjust a transaction or 
change who is credited with the transaction.

 ( p_api_version         =>  1.0,

 x_return_status         =>  l_return_status,  -- OUT parameter

 x_msg_count             =>  l_msg_count,  -- OUT parameter

 x_msg_data                =>  l_msg_data,  -- OUT parameter

 p_line_id                     => 1234,  -- Line Table Id

 p_source_doc_type   =>  ’LEG’,  -- Transaction Source Type

 p_adjusted_flag        =>  ’Y’,  -- Adjustment(not new record)

 p_header_id             => 1001, -- Header Table Identifier

 p_org_id                     =>  your_org_id,  -- Operating Unit (optional)

 x_loading_status     =>  l_loading_status  -- OUT parameter

 );
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Prerequisites
Super User or Analyst responsibility is required.

The application has collected the transaction.

Steps
1. In the Tasks menu, choose Adjustments.

The Maintain Transaction window appears.

2. Conduct a Find.

A list of transaction records appears.

3. Select the transaction record you want to adjust.

4. Click Adjust Transaction.

The Adjust Transaction window appears.

5. If you want to make a simple manual adjustment, then enter the adjustment 
information and save. If not, then go on to step 6.

6. Click the correct button for the type of adjustment you want to perform:

■ Move Credits

The credit moves from the existing credited salesperson to a salesperson 
you specify.

■ Share Credits

The original salesperson’s credit remains the same, but you also give the 
credit to a salesperson you specify.

■ Deal Split

You specify additional salespeople and the percentage of credit each 
salesperson receives for the transaction. The percentages must total 100.

■ Deal Move

Credit for the whole transaction is removed from the existing credited 
salesperson to a salesperson you specify.

■ Deal Share

The original salesperson’s credit remains the same, but you also give the 
credit to a salesperson you specify.
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7. Enter the appropriate information.

8. Click OK.

Guidelines
You can create a new manual transaction by selecting New Transaction.

You cannot split a nonrevenue, obsolete, frozen, or reversal transaction.

If a transaction has not yet been collected, then you can adjust the order or invoice 
directly. The correct transaction credit information is then collected by the 
application.

You can adjust more than one record at a time.

Setting up Classification

 Creating Revenue Classes and Hierarchies 
Revenue classes are user-defined categories of business revenue used to determine 
whether a sales credit is applied toward a compensation payment. A hierarchy 
composed of broader revenue classes at the top, or root, with subclasses as children 
of the root, make it possible to pay compensation for broader revenue classes 
without specifying all possible subclasses in a compensation plan. Use this 
procedure to define your revenue classes and build hierarchies of revenue classes.

Categorizing Your Sales Revenue
You begin defining revenue classification by identifying your organization’s 
revenue classes and then defining these classes in Oracle Sales Compensation.

What Is a Revenue Class?
A revenue class is a user–defined category of sales for which your organization 
awards compensation. Each revenue class represents a different type of sale for 
which your organization pays compensation. Thus, different companies have 
different revenue classes because each sales organization awards compensation 
differently. After defining your organization’s revenue classes, you assign one or 
more revenue classes to a compensation plan and assign the plan to a salesperson. 
By assigning revenue classes, you specify the types of revenue for which each 
salesperson can earn compensation.
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Many companies award compensation based on the types of products or services its 
salespeople sell. Depending on the business practices of your sales organization, 
you might award compensation based on factors other than products or services 
sold. For example:

■ Your sales organization might have customer account teams, where salespeople 
only receive compensation for sales to their assigned set of accounts. In this 
case, each customer account is probably a separate Oracle Sales Compensation 
revenue class.

■ Your company might organize its sales strategy around expansion into new 
markets, where each new market is defined as a separate revenue class.

■ Your company might use industry–based sales compensation, paying 
compensation only for sales made in a salesperson’s assigned set of industries.

For a specific example, Global Computers awards compensation based on the types 
of products or services its salespeople sell. At the broadest level, the company sells 
PCs, peripherals, education services, consulting services, and support maintenance 
services. While some types of salespeople, such as resellers, are only authorized to 
sell a subset of this offering, the company awards compensation to some of its 
salespeople for all types of products and services. Thus, for Global Computers, each 
product or service category is an Oracle Sales Compensation revenue class.

Defining a Revenue Class
A revenue class is a user-defined category of sales for which your organization 
awards compensation. Many organizations award compensation based on the types 
of products and services they sell. In that case, the products and services are 
grouped into revenue classes and arranged into hierarchies with broader categories 
at the top, or root, of the hierarchy.

When matching the revenue class on a compensation transaction, such as a sales 
order, to a revenue class on a salesperson’s compensation plan, the class of the 
transaction is rolled up in the revenue class hierarchy to determine matches to any 
revenue class on the plan.

All revenue classes on the same plan element share the same quota and 
compensation rate table. If revenue classes in a compensation plan have different 
quotas or are paid according to different rate tables, you must create a plan element 
for each revenue class that has a different quota or compensation rate.

Use this window to create Revenue Classes.
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Prerequisites
None.

Steps
1. In the Navigator, choose Classification Rules > View By Revenue Classes.

2. In the hierarchy, right-click Revenue Classes and choose New.

The Revenue Class window appears.

3. Enter the names and descriptions for all revenue classes you have identified.

4. Select a Liability Account and Expense Account, if applicable.

5. Save your work by clicking File in the toolbar and Save in the drop down 
menu.

Revenue Class Hierarchy
Use this window to assemble Revenue Classes into hierarchies.

Prerequisites
Revenue Classes have been created.

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.

2. Enter a name for your hierarchy.

3. Enter the start and end dates for the hierarchy.

4. Save your hierarchy.

5. Click View Details.

The Hierarchies window displays the existing available root classes. The 
application provides a default root class called Base Node.

6. Enter one or more root class names.

When you select the root name, it appears in the large box. A plus sign next to 
the name in the box indicates you can click it to expand and view the hierarchy 
that is part of the selected root. You can expand and view any level of the 
hierarchy.
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7. In the large box, select the parent revenue class for which you want to add a 
child.

8. Click Add.

The Hierarchy Elements window displays the existing children for the selected 
revenue class.

9. Use the list of values to add a revenue class.

10. Click OK.

The added revenue class appears in the hierarchy.

11. Repeat from step 6 to step 11 to build your hierarchy.

12. Save your work periodically and again before you exit the window.

Guidelines
You can create as many hierarchies as you need. However, only one hierarchy can 
be effective at any given time.

You can import any portion of another hierarchy to become a child of your selected 
node in the hierarchy you are building.

Creating Classification Rules
A classification ruleset is used to classify sales transactions to determine the 
appropriate revenue class for the transaction. Using the revenue class, a transaction 
is matched with a compensation plan and a compensation amount to be paid for the 
transaction is calculated. Use this procedure to define a set of attributes and values 
that uniquely identify each revenue classification.

Guidelines
Name your rules after the revenue classes they describe. Rules do not require 
unique names.

Tables
Use this window to define the descriptive flexfields in CN_COMMISSION_
HEADERS table.

Prerequisites
Super User responsibility is required.
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Steps
1. From the Menu bar, choose Toolbar > System > Tables and Columns.

2. Place the cursor on the first line in the Schema column. Find the CN Schema 
and the CN_COMMISSION_HEADERS table.

3. You can use descriptive flexfields ATTRIBUTE1 through ATTRIBUTE100 in the 
CN_Commission_Headers table to classify a transaction into a revenue class. In 
order to use the flexfield, Classification Value must be selected for the column 
using the Tables and Columns function. 

4. The Column Datatype must also be set to either numeric or alphanumeric (the 
default is alphanumeric). 

5. You can also specify a Valueset Name. The valueset should be table validated. 
The values in the specified valueset are used in the Value field instead of 
unvalidated data entry when you are defining a rule attribute. Value sets can be 
defined through Application Developer and System Administrator 
responsibilities. See Oracle Application Object Library manual.

Flexfields
A flexfield is a field made up of subfields, or segments. There are two types of 
flexfields: key and descriptive. Sales Compensation uses descriptive flexfields, 
which provide customizable "expansion space" on forms. 

In the current version of Sales Compensation there are 13 flexfields, as listed in the 
table below. See the Oracle Applications Flexfields Guide for information about setting 
up flexfields.

Flexfields

Commission Headers CN_COMMISSION_HEADERS_ALL

Commission Lines CN_COMMISSION_LINES_ALL

CN Compensation Plans CN_COMP_PLANS_ALL

CN Quotas CN_QUOTAS_ALL

CN Quota Rules CN_QUOTA_RULES_ALL

CN Rate Tables CN_RATE_SCHEDULES_ALL

CN SRP Comp Plan Assignments CN_SRP_PLAN_ASSIGNS_ALL

CN SRP Quota Assigns CN_SRP_QUOTA_ASSIGNS_ALL
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Defining Other Dimensions

Steps
1. Ensure that the table you base your dimension on exists in the database by 

navigating to the Dimensions window and selecting the list of values in the 
Base Table field. 

By default, choose Dimensions from the Setup menu to open the Dimensions 
window.

2. Define the dimension table in the Oracle Sales Compensation using the Tables 
and Columns form (Setup> Tables and Columns). Enter the table name and 
column names. The dimension table must have a Primary Key and a column 
that stores the actual dimension values.

3. Open the Dimensions window again.

4. In the Name field, enter the name of the new dimension.

5. In the Base Table field, enter the name of the table for the new dimension or 
select the table name from a list of values. (If a table has a dimension based on it 
already, it will not appear in the list of values for this field.

6. In the Primary Key field, enter the name of the column defined as the Primary 
Key in this table (as defined in the Tables and Columns form).

7. In the Dimension Values field, enter the name of the column that stores the 
values that will appear in the hierarchies.

8. Define one or more hierarchies for this dimension and save your work.

Ruleset
Use this window to create a classification Ruleset and Account Generation.

CN SRP Quota Rules CN_SRP_QUOTA_RULES_ALL

CN Trx CN_TRX_ALL

CN Trx Batches CN_TRX_BATCHES_ALL

CN Trx Lines CN_TRX_LINES_ALL

CN Trx Sales Lines CN_TRX_SALES_LINES_ALL

Flexfields
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Prerequisites
Revenue Classes have been created and the user-defined flexfields of the CN_
COMMISSION_HEADERS table have been defined.

Steps
1. In the Navigator, choose Classification Rules > View By Classification Rules.

2. In the hierarchy, right-click Classification Rules and choose New.

The Ruleset window appears.

3. Specify a name for your set of classification rules and assign active start and 
end dates.

4. Select Revenue Classification type or Account Generator.

5. Save the ruleset.

The new ruleset appears in the Navigator.

6. Close the Form and return to the Navigator. 

7. Right-click the ruleset that you have just created and select Add new child Rule. 

The Rules Form will appear. 

8. Define your classification rules on the Rules Form and return to this Form when 
completed.

9. For every Ruleset that has new or changed rules, click Synchronize. 

Ruleset Status displays either Complete if the currently defined revenue classes 
and rules have been synchronized, or Incomplete if you have made changes in 
your definitions since they were last synchronized.

When you click Synchronize, the classification rules package is automatically 
installed in the database using the concurrent program named Install 
Classification Rules Package.

Guidelines
You can define multiple date-effective classification rulesets. Ruleset active dates 
may not overlap.

A hierarchy of rules can be defined for each ruleset.

Every rule must have at least one attribute.
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A rule may or may not have a revenue class. If the rule does not have a revenue 
class, then its children rules must define the revenue class. If a rule has a revenue 
class, then the revenue class is assigned to the transaction only if none of its child 
rules match the transaction.

If you specify high and low values in a rule condition, the values can be 
alphanumeric.

Hierarchy Values: Selecting this option allows you to enter the value in the 
hierarchy you want to match. The fields that appear are Hierarchy and Hierarchy 
Values. If the value of the transaction attribute rolls up the hierarchy to the value 
you specify, then the compensation transaction satisfies the condition.

Not: Specify the inverse of a value you defined by checking Not. The compensation 
transaction satisfies the condition if the attribute is not equal to the specified value, 
is not between the range of values specified, or does not roll up to the specified 
ancestor value.

When you add rules and revenue classes, you must synchronize the new rule and 
revenue class definitions before they can be used in compensation plans. You do not 
need to synchronize if you only rearranged the rules.

Always customize the classification rules using the setup forms available. Do not 
modify the generated PL/SQL code.

Troubleshooting
When a transaction fails classification for a rule that uses hierarchy values, the most 
common problem is that the primary key value in the transaction attribute column 
is not the same as the primary key value defined in the hierarchy (the value for the 
EXTERNAL_ID field).

Rules
Use this window to define the classification rules.

Prerequisites
Classification Ruleset has been created.

Steps
1. In the Navigator, right-click the Ruleset that you have just created and select 

Add New Child.

The Rules window appears.
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2. Assign a name to the rule that you are about to define.

3. Select a revenue class from the list of values. Optionally select Expense & 
Liability account.

4. In the Rule Attributes tab, choose a user column name from the list of values, 
choose the type of values from the drop-down list, and enter the value or values 
that apply.

5. Optionally, enter additional attributes for the rule.

Every attribute is assumed to be linked to other attributes with AND.

6. If you want any of the attributes to be related with OR, use the Build Expression 
tab to relate the first two attributes with AND or OR.

An additional value of Result1 appears in the first column and is added to the 
attribute list of values.

7. Continue to relate the remaining attributes. Use Result1 to relate a third 
attribute to the first two.

8. Save the rule.

The expression appears.

9. To add rules in the hierarchy of rules, position your cursor over the parent rule, 
right click, and choose New Rule. Repeat from step 2.

10. Return to the Ruleset Form for every ruleset that has new or changed rules and 
click Synchronize.

Guidelines
Name your rules after the revenue classes they describe. Rules do not require 
unique names. 

Build Expressions
Use this window to create a relationship between multiple rule attributes. For 
example, you can define the following rules and assign them to this expression:

ITEM_ID = ABC

ITEM_ID = 124

Oracle Sales Compensation treats the rules attributes as having an "AND" 
relationship. The Build Expression function allows users to change and refine these 
relationships. For example, users can redefine the rule as being:
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ITEM_ID = ABC or ITEM_ID = 124 

Prerequisites:
Multiple rule attributes have been assigned.

Steps
1. Select the Build Expression tab.

2. Select a rule attribute from Operand 1.

3. Select And or Or condition from the operator.

4. Select a rule attribute from Operand 2.

5. Repeat steps 2-4 until the desired expression has been created.

6. Press Finish and save the rule.

Defining a Hierarchy

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.

2. In the Name field, select the dimension for which you are defining a hierarchy.

3. Choose Hierarchies. Use the Hierarchies window that opens to add and view 
hierarchies.

4. Enter the name of the new hierarchy.

5. Enter the period you want the hierarchy to be effective. Choose From and To 
periods from a list of values. Two hierarchies in the same dimension cannot 
have overlapping periods.

6. Add nodes to a hierarchy. Save your work.

Adding Nodes to a Hierarchy

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.
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2. Select a hierarchy, then choose Nodes. 

Use the window that opens to define the parent-child relationship between all 
nodes in a hierarchy.

3. Start at the top of the hierarchy; define the nodes in your hierarchy.

By default, Oracle Sales Compensation names the highest level root of every 
hierarchy BASE NODE. You can change this name. Use the Current Root menu 
to change the root your are defining.

4. Enter the names of all children of this node. Use the list of values to select the 
children.

5. To define the next level in the hierarchy, select a child node, then choose 
Children.

The child moves to the Current Node position and Oracle Sales Compensation 
displays the children of the new parent, if they exist.

6. Enter the names of all children of this parent.

7. Choose Parent to go one level up in the hierarchy.

8. Repeat steps 4 through 7 to define all nodes in the hierarchy.

9. Save your work and exit the window.

Deleting Nodes from a Hierarchy

Steps
1. In the Hierarchies window, choose Nodes.

2. Select the node you want to delete and then choose Delete Record from the Edit 
menu. 

3. Save your work and exit the window.

Setting Up Compensation Plans

Defining Calculation
There are 100 user definable column attributes. You can use these Calculation 
Expressions as Performance Measures, Input Expressions, Output Expressions, or 
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Rate Table Dimensions. You can also nest a Calculation Expression within another 
Calculation Expression.

As part of the definition process you can select columns from a list of table columns 
on the form called Forming Calculation Expressions to create expressions. Once 
they have been saved they can be assigned and reassigned to any number of 
formulas you need.

Do this by selecting a valid Expression from a List of Values at each of the windows 
for performance measure, input and output.

A Performance Measure can be an accumulation of transaction values that are 
captured by the Plan Element that it is assigned to. Performance Measures serve as 
a mechanism to gather cumulative information by Plan Element and group them for 
use in reports that compare achievements to Quota, Goal and Performance 
Measure.

An example of a Performance Measure is Revenue. You would select and define the 
columns where revenue information for transactions are held. As transactions are 
entered and collected for the assigned Plan Element, the transaction values are 
accumulated. An example Performance Measure looks like this:

TRANSACTION_AMOUNT

Input Formulas instruct Sales Compensation what to evaluate from the transactions 
and how to match the results to the corresponding rate table. Think of the input 
expression as a sorter for all incoming transactions for Sales Compensation. An 
example Input Formula expression looks like this:

(TRANSACTION_AMOUNT*EVENT_FACTOR)/TARGET 

For example, as a condition a company can establish that its sales force will be 
compensated based on transaction amount. The input expression will merely state 
that transactions will be sorted by TRANSACTION_AMOUNT from the CN_
COMMISSION_HEADERS column.

This is an example of a rate table:

$0 - $100 4%

$100 - $500 5%

$500 - $99,999 6%
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As transactions are ‘sorted’ by through the input expression they are matched to the 
rate table tiers established. If a transaction is collected in Oracle Sales Compensation 
with the following attributes:

1. Customer X

2. Transaction Amount $100

3. Product Z

Oracle Sales Compensation, using the input expression created will match the 
above transaction of $100 with the rate table and determine that 4% will be paid on 
this order. 

Outputs of the formula instruct Sales Compensation how much to pay salespeople. 
The payment amount can either be tied to a rate table or not. This will be 
determined by the users.

In this example above, business users determined that the salespeople will be paid 
based on the rate table result, transaction amount, and a constant uplift/accelerator 
factor of 1.035. Users will need to instruct Sales Compensation the columns where 
all this information resides and apply the calculations.

Example of an output expression:

Rate Table Result * (TRANSACTION_AMOUNT * PAYMENT_FACTOR)

Using the above output expression, multiply 4% with the transaction amount 
($100), event factor of 100% and 1.035 for the payment accelerator or payment 
uplift. The 4% is multiplied by the result of the sum in the brackets. If the payment 
factor is 1.05, then the result or commission is $4.20 ($100 x 4% x 1.05 = $4.20).

Forming Calculation Expressions
Use this window to define calculation expressions or parts of your formula that can 
be reused in other formulas. 

Prerequisites
Table and column mapping is complete.

Steps
1. From the Navigator choose Compensation Plans, View By Calculation 

Expressions.
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2. In the hierarchy, right-click Calculation Expression and choose New. The 
Calculation Expression window will appear.

3. Enter a unique name for the expression.

4. Optionally, provide a description for the expression.

5. From the Calculation Values box, select the column to be used in the expression.

6. Once a selection has been made, press the arrow key to move the column into 
the Expression box. The column should appear in the Expression as soon as the 
arrow has been pressed. To remove an item press the lower arrow button to 
remove an entry from the Expression box.

7. Select an operand from the Operation box. Once an operand has been pressed it 
will appear in the Expression box. Again, to remove an item from the 
Expression box, press the lower arrow button.

8. Optionally, numeric constants can be added to an expression. Enter the numeric 
value desired in the number field and press the upper arrow button to move it 
to the Expression box. To remove a item press the lower arrow button to remove 
an entry from the Expression box.

9. Repeat step 5 through 8 until the desired expression has been created.

10. Optionally, to view the SQL statement generated for the expression check the 
’Show SQL’ box in the lower right hand corner of the window.

11. Optionally, press the Clear button to restart the create expression process 
without saving the work.

12. Once all elements and operands have been assembled for the expression, save 
the expression. 

13. Press the ’Compile’ button to ensure there are no logic errors or rule violations 
in the expression.

14. The status of the expression should read Valid after it has been compiled.

15. The usage of the expression will also be displayed once it is saved. The usage 
rules will determine where the expression may be applied. 

Guidelines
A Commission Expression must include at least one column from the following 
tables:

■ cn_commission_lines
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■ cn_commission_headers

A Bonus Expression cannot include a column from the following tables or any 
external table that is mapped to these tables:

■ cn_commission_lines

■ cn_commission_headers

■ cn_srp_period_quotas

A Commission Expression cannot include an element from the table cn_srp_periods 
or any table that is mapped to this table.

A Bonus Expression cannot include an element from the table cn_srp_period_
quotas or any table that is mapped to this table.

User table names are listed under External Elements in the Calculation Values tree. 
You join an external table to an internal table by mapping them using System > 
External Tables.

A Bonus Expression cannot be used as an embedded formula and cannot be mixed 
with a commission type formula.

Selected columns are accessible in the calculation values tree for use in building 
formulas and performance measures. The user column name is listed in the tree 
rather than the actual column name.

The following Oracle Sales Compensation tables are predefined in the system and 
can be used as calculation values in defining performance measures and formulas:

CN_COMMISSION_HEADERS
CN_COMMISSION_LINES
CN_SRP_QUOTA_ASSIGNS
CN_SRP_PERIOD_QUOTAS
CN_SRP_PERIODS
CN_QUOTAS

A Rate Dimension expression can only be used from the following list of columns:

1. CN_SRP_PERIOD_QUOTAS

2. CN_SRP_PAN_ASSIGN

3. CN_SRP_QUOTA_ASSIGN

4. CN_SALESREP
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Defining Rate Tables
Rate tables are used to establish compensation percentage rates or fixed amounts 
for different performance levels. The compensation formula and plan element 
determine the type of information to be compared to the rate table as well as how 
the resulting rate is used in the calculation. Use this procedure to define your rate 
tables.

Prerequisites
Rate Dimensions must exist.

Steps
1. In the Navigator, choose Compensation Plans > View By Rate Tables.

2. In the hierarchy, right-click Rate Tables and choose New.

The Rate Tables window appears.

3. Enter a unique name for the Rate Table. Select a Rate Table type, either an 
Amount type or a Percentage type.

4. In the next block select a rate Dimension that you created previously.

5. Click in Commission Rate box and enter rates.

6. Save your Rate Table if this is not a multidimentional rate table.

For multidimensional rate tables use the following steps:

1. In the navigator, choose Compensation Plans and then View By Rate Tables 
from the drop down menu.

2. Right click New.

3. Enter a unique name for the Rate Table. Select a Rate Table type, either an 
Amount type or a Percentage type.

4. In the next block select a rate Dimension that you created previously.

5. Repeat step 4 to apply each additional dimension to be added to this rate table.

6. Click check box and select the dimension you want to use as the Base 
Dimension. Base Dimension is the constant view of the rate table shown in the 
Commission Rates box.

7. Navigation in the Current Tier box determines the choices users have in the 
Selected Dimension Tier box. Select, in turn, each element located in the Current 
Tier box except the base dimension.
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8. In the Selection Dimension Tier box, select the string value that corresponds to 
the base dimension in the Commission Rates box.

9. Then, enter the commission rate to be paid if the dimension combinations are 
met.

10. Repeat steps 7-9 until all dimension combinations are complete.

11. Save the Rate Table.

Rate Dimensions
Rate dimensions define the tiers that a rate table uses to apply rates. 

If a commission rate is based on multiple criteria, then a multidimensional rate table 
must be created to reflect all criteria: one dimension per criterion. 

Note: This version of Sales Compensation does not support accumulated revenue 
with multidimensional rate tables.

In the following example, three dimensions are used to calculate various 
commission rates: License Revenue (percent of quota), State, and Product. The 
formula first compares transaction revenue with the first dimension, License 
Revenue. Next, the formula compares transaction location with the second 
dimension, State. Finally, the formula compares product identification with the 
third dimension, Product.

A dimension contains rate tiers to establish different levels of achievement to be 
compensated at different rates. In this example, two dimensions have two tiers and 
one has three, but any number can be defined. 

The License Revenue dimension: 

0-100

100-9,999

The State dimension:

Arizona

California

Oregon

The Product dimension:

PCs

Peripherals
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Together, there are 12 possible combinations, and each one can be assigned a 
different commission rate.

Your minimum and maximum values in the Rate Tiers section must be stated in 
terms consistent with your input information.

You can change both the tiers and rates for a rate table. Any changes you make are 
propagated to all plan elements to which those rate tables are assigned, and thus to 
any salespeople that use plans containing those plan elements. If you change the 
levels of quota achievement in a tier, or add or delete a tier in a rate table, those 
changes propagate to all salespeople, regardless of whether their plans have custom 
quotas or rates. 

The following table shows four columns of a Dimension and Rates Example. 
Columns are License Revenue, State, Product, and Rate. Product is chosen as the 
base dimension. There are 6 possibilities for each of the two tiers in the License 
Revenue dimension, including all combinations with the other two dimensions.

Prerequisites 
For an expression type dimension, the expressions must already be defined.

Dimension and Rates Example

License Revenue State Product Rate

0-100 Arizona PCs 1%

0-100 Arizona Peripherals 5%

0-100 California PCs 1.5%

0-100 California Peripherals 4.5%

0-100 Oregon PCs 1.25%

0-100 Oregon Peripherals 6.25%

100-9,999 Arizona PCs 4%

100-9,999 Arizona Peripherals 8%

100-9,999 California PCs 4.5%

100-9,999 California Peripherals 7.5%

100-9,999 Oregon PCs 4.25%

100-9,999 Oregon Peripherals 9.25%
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Steps
1. In the Toolbar, select Tasks > Rate Dimensions.

2. Enter the name of the rate dimension.

3. Select the dimension type:

■ Amount

■ Percentage

■ String

■ Expression

4. Enter the tier values. The tier sequence will be numbered automatically as you 
progress through each level of achievement.

5. Save the dimension.

Guidelines
If the application is unable find a match in a string dimension rate table, the 
application will pick the last rate value by default. For example, suppose that in the 
example above, a transaction has dimension values of 10,000, Iowa, and Service. No 
matches will occur, and the rate table result will be 9.25%, the last value in the Rate 
column. 

If you do want non-matching transactions to receive commission, add "OTHER" as 
the last string value to each string dimension with a corresponding commission rate 
of 0, for example. 

Another method of dealing with non-matching transactions is to use classification 
rules. Transactions with attributes that do not match your classification rules will 
have a failed classification status. If required, you can correct these failed 
transactions’ attributes by changing their values and maintain a record of the 
adjustment through the manual adjustments window. 

Creating Formulas
You have complete flexibility to create formulas for calculating compensation. Your 
formulas can be used in another formula definition or in a plan element definition. 
Use this procedure to create formulas.

You can save an incomplete formula and return to complete it later.
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Prerequisites
If you wish to incorporate Calculation Expressions into your formula, then these 
Expressions must be created before you reach this stage. These Expressions can be 
repeated in your formula and can also be reused in other formulas as well. Please 
see the Guidelines section of Forming Calculation Expressions for more information 
on the types of calculation expressions that you can use for Commission and Bonus 
Formulas.

Any column from any table can be part of your formula, providing the Calculation 
Value check box for the column is selected in Columns and Tables. (See Defining 
Calculation.)

Rate tables must be created first if you want to include them in your formula. (See 
Defining Rate Tables.)

Steps
1. In the Navigator, choose Compensation Plans > View by Formulas.

2. In the hierarchy, right-click Formulas and choose New.

3. In the general tab, enter a unique name and a description for your Formula.

4. Decide whether your Formula is for calculating a Commission or a Bonus. 
Make your selection at Type.

5. In the next block, determine your calculation rules.

6. In the last block, select a Calculation Expression that will become your 
Performance Measure. Performance Measure as well as Quota will be used in 
Reports for comparison with achievement.

7. In the Input tab, select a Calculation Expression to represent your input 
formula. The number of Input Calculation Expressions must equal the number 
of Dimensions in the Rate Table that you will select in the next step. And, they 
Input Calculation Expressions must be listed in the order they were assigned in 
the Rate Table.

8. If applied rates are part of your formula, then in the Rate Table tab, select the 
rate tables to apply to the formula and enter their effective start and end dates. 
You can view the Rate Table details and rates for each dimension by clicking on 
the Rate Table Details button.

9. Optionally, forecast version Expressions may be assigned. This enables the 
formula to be used by the Income Planner of Sales On Line. Please see Sales On 
Line for details.
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10. Select Rate Table tab and assign Start and End dates.

11. In the Output tab, select your output Calculation Expression.

12. Return to the General tab and click Generate. On completion, the validation 
process will return a Complete status.

Guidelines
A Bonus Formula is a type of Formula where there are no links or references to 
transactions. See the Guidelines section of Forming Calculation Expressions for 
more information.

Apply transactions individually if you want each transaction calculated separately 
to determine a rate. Group transactions if you want transactions aggregated to 
determine the rate.

Select the Accumulative check box if transactions are required to be aggregated in 
total. Rate applied will be determined by the transactions-total achieved to date 
within the interval.

Dependency Notes

Formula Commission

1. Individual Option for Transactions can be used with any Accumulate/Interval 
to Date/Threshold option.

a. By default Interval to Date and Accumulate options must be used together. 
Users cannot select Interval to Date by itself. Split options are selectable 
(each is mutually exclusive).

b. By default Threshold and Accumulate options must be used together. Users 
cannot select Threshold by itself. Split options are not available for 
Threshold calculations.

c. Accumulate can be selected by itself. Split options are selectable (each is 
mutually exclusive).

2. Group by Interval for Transactions can only be used with Accumulate. Split 
options are selectable (each is mutually exclusive).

Formula Bonus

Bonus formulas calculate only against Individual transaction options. Split options 
are selectable (each is mutually exclusive).

Use interval to date quotas and fixed amounts if:
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■ Quotas are set each period

■ Quotas are set cumulatively within the interval

■ Performance to date is to be compared to the quota to date

Choose Thresholds if you want all prior transactions within the interval paid 
retroactively at the higher rate once that higher rate is achieved through 
accumulative transactions.

Do not split tiers if you want a rate from the Rate Table applied to the full amount. 
Split tiers if you want portions of the full amount paid at each rate up to the top 
qualifying rate. For example, the Rate Table shows 0-1000 at 1%, 1000-2000 at 2%. 
The transaction amount is 1500. If you check the No Split check box, 2% will be 
applied to the whole transaction amount of 1500. If you check the Non Proportional 
check box, 1% will be applied to 1000 and 2% will be applied to 500.

The Proportional check box is intended for use with Amount Rate Tables. Example, 
if the Rate Table shows 0-1000 at 100, 1000-2000 at 200. The first transaction amount 
is 200. The commission for this transaction is 20 because 200 is one fifth of the first 
rate tier and one fifth of the 100 rate is 20. If the second transaction amount is 1300, 
the remaining four fifths of the first rate tier will pay 80 and half of the second tier 
[(1300-800)/(2000-1000)] will pay 100 (half of the rate 200). Total commission for the 
second transaction is 180.

Defining Plan Elements
A plan element is a set of conditions a salesperson must meet to be eligible for 
compensation. It determines how the compensation is calculated. Use this 
procedure to define plan elements.

Prerequisites
If the plan element includes a formula, then the formula must be created first. (See 
Creating Formulas.)

If the plan element includes a rate table, then the rate table must be created first. 
(See Defining Rate Tables.)

If the plan element includes a revenue class, then the revenue class must be defined 
first. (See Creating Revenue Classes and Hierarchies.)

Steps
1. In the Navigator, choose Compensation Plans > View By Plan Elements.
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2. Right-click on Plan Elements and select new.

3. In the General tab, in the first block:

■ Enter a unique name for your Plan Element.

■ Enter its Start and End dates.

■ Enter a description of its objective.

■ You may copy from an existing Plan Element by clicking on the Copy Plan 
Element button to make a duplicate of the displayed Plan Element. The name is 
changed with a “_2” attached to the end of the Plan Element name. 

■ Optionally, to start a new Plan Element, click on the New Plan Element button.

■ In the Quota Group field, select either Quota or Bonus. If you select Quota, this 
Plan Element will appear in the top half of the YTD Summary Report. If you 
select Bonus, then this Plan Element will appear in the lower half of the YTD 
Summary Report.

4. In the second block of the General tab: 

■ Select the Interval, Incentive type, Credit type, Formula type and a Formula. If 
you choose External Formula type, you must enter the name of the PL/SQL 
procedure. If you choose Formula type, select a Formula that has a Complete 
status.

■ If you want the Plan Element and the eventual payment to be assigned to 
someone other than the Salesperson credited with the sale, check the Eligible for 
Payee Assignment check box. 

■ Tick the Calculate Last check box if you want this Plan Element to be calculated 
after all the other Plan Elements assigned to the same Compensation Plan as 
this Plan Element is, are calculated.

■ Optionally, select Liability and Expense Account codes information that you 
want sent to Oracle Accounts Payable Invoice Interface Table for all future 
commission payments relating to this Plan Element.

5. In the last block of the General tab, enter the Quota, Fixed Amount, and Goal 
figures. These are measures that will be used to compare against actual 
achievements. If you have Quota, Fixed Amount and Goal figures against 
individual Revenue Classes assigned to this Plan Element, you can check the 
Sum amounts from Revenue Classes check box and the totals will appear in 
these 3 fields. The Distribute Variables button will be available once a Formula 
with Interval to Date checked is assigned to your Plan Element. The Distribute 
function allows you to seasonalize your Quota, Fixed Amount and Goals.
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6. In the Revenue Classes tab, assign your Revenue Classes to this Plan Element. 
You may have Quota and Payment Accelerators at Revenue Class level for an 
effective period that you can specify through the Start and End Dates. Ensure 
that your Transaction or Event factors add up to 100% in total. Example, you 
can have 50% of the Order value calculated for commission, 20% of the Invoice 
value and 30% of the Payment amount for commission calculation. Other 
Factors do not need to total 100% and each can be over 100% if you require.

7. The Formula tab will display the Formula that you have assigned under the 
General tab earlier.

8. Similarly, the Rate Table tab will display the rates associated with the Formula.

9. Save your new Plan Element so that it will be available for assigning to a 
Compensation Plan.

Guidelines
You can assign multiple plan elements to a compensation plan, and you can assign 
the same plan element to multiple compensation plans.

When you change the structure of a plan element, it applies to every compensation 
plan that uses it and for every salesperson assigned to that plan. The affected 
compensation plans must again be validated.

The Plan Element’s effective dates must be within the dates of the compensation 
plans to which the plan element is assigned.

You can change any part of a plan element before it is assigned to a salesperson. 
Any changes you make are propagated to all plans to which those plan elements are 
assigned, and thus to any salespeople that use those plans.

Once a compensation plan has been assigned to a sales role, you cannot change the 
plan’s interval type. If you have assigned the plan and you want to change the 
interval for a plan element, you must remove the plan assignment, change the plan 
element’s interval, then reassign the compensation plan.

How the Accelerators and transaction factors are used will depend on how your 
Calculation Expression is defined. Example, a common Input Expression that 
complements a percentage rate table is as follows:

EVENT_FACTOR* QUOTA_FACTOR*TRANSACTION_AMOUNT/TARGET. 

An Output Expression is as follows:

Rate_ Result* TRANSACTION_AMOUNT* EVENT_FACTOR* PAYMENT_
FACTOR. 
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Note: For Plan Elements with Incentive type of Manual and Formula type of None, 
rate tables are assigned through the Rate Table tab on the Plan Element form. You 
can change the rate table assigned to a Plan Element at any time, regardless of the 
Rate Table assigned to the Formula.

Defining Compensation Plans
A compensation plan is built from plan elements and is assigned an effective start 
and end date. The plan can then be assigned to multiple sales roles.

Use this procedure to define a compensation plan.

Prerequisites
Plan elements and formulas must be created if they are to become part of the 
compensation plan.

Steps
1. In the Navigator, choose Compensation Plans > View By Plan Elements.

2. In the hierarchy, right-click Compensation Plans and choose New.

The Compensation Plans window appears.

3. Assign a unique name to the new compensation plan.

4. Assign start and end dates to the plan.

5. Enter the objective description for this plan based on the associated sales role. 
The description is used as part of a contract for the salesperson.

6. Check the Allow Revenue Class overlap check box if you want your Plan 
Elements to use the same Revenue Classes. 

7. Select plan elements to be included in the plan and assign each plan element 
effective start and end dates.

8. Optionally, select a plan element and click Element Details to review plan 
element details.

The Plan Element window displays the selected plan element information.

9. Click Validate to ensure that you have entered the plan information correctly. 

When you validate a compensation plan, the following are verified:

■ The plan has a name and start and end dates
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■ The plan has one or more plan elements assigned with start and end dates 
within the plan start and end dates

■ Each plan element has a rate table with contiguous tiers and with start and 
end dates within the plan start and end dates

■ Each plan element has at least one revenue class assigned that has start and 
end dates within the plan start and end dates

■ Each plan element has a rate table structure that makes sense for the plan 
element type

■ Each revenue class has at least one key transaction factor and at least one 
other transaction factor

If each of the above conditions is true, then the Status field shows Complete. 
When the Status field displays Incomplete, the plan cannot be used to calculate 
compensation.

10. Save the plan.

When you save a plan, the values of that plan become the default values when 
you assign it.

11. Optionally, edit the start and end dates for individual salespeople. When the 
compensation plan is assigned to a sales role, the sales role and salespeople 
assigned to the sales role display in the compensation plan window. 

Guidelines
Consider defining plan names by job titles or area of sales you are compensating.

When you assign a plan to a salesperson, you define assignment start and end 
effective dates between which the salesperson is on that plan. Because you can 
assign the same plan to many salespeople, ensure the plan period is broad enough 
to encompass all necessary assignment periods. 

You can change or restructure any aspect of a compensation plan. Because you can 
assign the same plan to many salespeople, however, ensure you are aware of how 
the changes you are making impacts individual salespeople.

When you change a compensation plan, the changes propagate to the salespeople 
assigned to the plans. For customized plans, the salesperson receives all changes 
except the customized changes. If a change is made to a tier in a rate dimension, 
then the new rates overwrite customized rates.
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Customizing Compensation Plans
You can customize each plan element in the compensation plan for an individual 
salesperson. Use this procedure to customize a compensation plan.

Prerequisites
None

Steps
1. Choose Salesperson from the Navigator. The Salespeople Workbench appears.

2. In the Compensation Plans tab, select a sales role.

The compensation plans and plan elements for the salesperson and sales role 
appear.

3. Select Customized next to the plan element to be customized.

If you leave the Customized check box unchecked for a plan element, then any 
changes you make to the quota or rates for that plan element are inherited by 
the salesperson.

4. Select the plan element name and click Details.

The Plan Element window displays the details for the plan element.

5. Edit the details to customize the plan. See the table under References for a list of 
fields that can be changed and where they can be found in the plan element 
tabs.

6. Save your changes.

Guidelines
Although you can customize the rates for individual salespeople, those 
representatives automatically inherit all changes made to other aspects of the 
compensation plan itself. For example, if you customize compensation rates for a 
salesperson and then delete a bracket in the rate table assigned to that 
compensation plan, then the salesperson’s rates default to those in the new rate 
table.

If you change the levels of quota achievement in a tier, or add or delete a tier in a 
rate table, then those changes propagate to all salespeople, regardless of whether 
their plans have custom quotas or rates.
100 Oracle Sales Compensation Implementation Guide



Setting Up Payment
Setting Up Payment
Pay Groups allow control over the frequency of payment for the members of the 
group. Payment Plans allow control over the payment amounts at a Salesperson 
level for all Salespeople who have the specific Payment Plan assigned to them. The 
Transaction Details window will allow controlled recovery or a payment hold at 
transaction level. In addition the Transaction Details window will also allow you to 
decide which transactions get paid as part of each Payrun.

This version of Sales Compensation introduces Oracle Payable integration. The 
integration allows you to pay your Suppliers, Agents or Brokers (also referred to as 
Salespeople and Resources in this Guide) through Oracle Accounts Payable 
payment processes.

Oracle Payable will only recognize the Salespeople for payment if they are activated 
as Suppliers through Oracle Purchasing. Please refer to Oracle Purchasing Guides 
for the activation procedure.

Defining Pay Groups
A pay group defines the frequency of payments, such as monthly or semi-monthly, 
for the salespeople who are assigned the pay group. Use this procedure to define 
pay groups.

Prerequisites
Calendars and related pay periods must be defined in GL and activated in Sales 
Compensation. 

Steps
1. In the Navigator, choose Payment Setup > View By Pay Groups.

2. In the hierarchy, right-click Pay Groups and choose New.

The Pay Groups window appears.

3. Assign a unique name to the pay group and enter a description.

4. Select effective start and end dates for the pay group.

5. Select a calendar from the list of values.

6. Select a period type from the list of period types that were defined for the 
selected calendar.
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The grid displays all pay periods for the selected calendar and period type that 
fall within the effective date range.

The Sales Representatives tab displays all salespeople who have been assigned 
the pay group using the Salesperson Workbench.

7. Save the pay group.

Guidelines
The period type defines the frequency of payments for the pay group. 

Each pay group can have one or many pay periods. A pay period is a range of dates 
over which calculated plan element commissions are collected for payment.

The pay group reflects the frequency of the pay periods.

Each pay group requires a separate pay run. See Payruns for information about 
creating a pay run.

Defining Payment Plans
Use payment plans to set rules governing how much is paid. Payment plans are 
optional and are used to set up advance or deferred payments. Use this procedure 
to define minimum and maximum payments and controlled recovery.

Prerequisites
Credit types must be defined.

Steps
1. In the Navigator, choose Payment Setup > View By Payment Plans.

2. In the hierarchy, right-click Payment Plans and choose New.

The Payment Plan window appears.

3. Assign a unique name to the payment plan.

4. Optionally, establish a minimum amount to be paid at the end of each pay 
interval, and whether or not it is recoverable from later commissions.

5. Optionally, establish a maximum amount to be paid at the end of each pay 
interval.

6. If you want any commission earned above the maximum payment to be 
included in a later pay run, then select Pay Later.
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7.  Save the payment plan.

The payment plan is available to be assigned to a salesperson in the workbench.

Guidelines
The application checks first for the minimum amount and pays it. Recoverable 
amounts are calculated after the minimum is met.

Oracle Payable Integration
In the new version of Oracle Sales Compensation, information can be transferred 
and posted from Oracle Sales Compensation to Oracle Payable. Expense and 
Liability Accounts can be assigned at three levels: plan element, revenue class, and 
classification. There is an interface table in Oracle Sales Compensation. After the 
data is mapped to the interface, the subledger is updated to reflect the amounts 
paid. The Liability Account will also be mapped to the Oracle Payable interface 
using the account generator in Oracle Sales Compensation. 

Enabling a Salesperson in Oracle Payable

Prerequisites
Switch to the Payables responsibility. From the Toolbar, select File and press Switch 
Responsibility. Select Payables from the list. 

Steps
1. On Functions tab, expand Suppliers.

2. Double-click on Entry to open the Suppliers form.   

3. Enter salesperson’s name as a supplier. Save.

4. Click Sites button at the bottom of General tab.

5. Enter site name. 

6. Click Contacts tab to create Contact. 

7. Enter contact name and information. Save.
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Assign Sales Role and Group

Prerequisites
Switch to the Sales Compensation Super User responsibility. From the Toolbar, 
select File and press Switch Responsibility. Select Sales Compensation Super User 
from the list.

Steps
NOTE: All items that have a reference of creating or assigning an item should be 
noted as a prerequisite prior to adding a Supplier to Oracle Payable.

1. In the Toolbar, press Tasks > Import Resources 

2. In Resource Category field, select Supplier Contact from the list of values.

3. Enter Name and Contact or select from the list of values.

4. Click Search. This populates the Search Results field.

5. Click Create Resource.

6. Verify Start Date, then click OK.

7. Click Save Resource, then click Details.

8. Create Sales Role and Compensation Group.

9. In Resource form, assign valid Salesperson number. 

10. Click Roles tab. Assign Role Type from list of values as Sales Compensation. 

11. Assign Role from list of values. Save.

12. Click Group tab and assign Group from list of values.

13. Click Save. Resources tab is displayed. Select desired sales credit type from list 
of values [Quota Sales Credit is used in Vision instance]. Save.

Assign Pay Group and Compensation Plan to a Salesperson

Steps
1. Click Sales People tab in the Navigator. 

2. Select View by Compensation Groups from drop-down menu at top of 
Navigator.
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3. Expand or double-click the Compensation Group node in the tree next to the 
Salespeople tab to display a listing of the Compensation Groups. 

4. Expand the tree node or double-click on desired Compensation Group to 
display Salesperson listing.

5. Double-click Salesperson’s name to open Salesperson Workbench.

6. On Salesperson Tab, select Pay Group from list of values.

7. Assign Compensation plan to Role.

8. Press Load transactions.

9. In the Toolbar, press Tasks > Submit Calculation.

10. Post details by using Concurrent request in Concurrent Manager.

Payruns

Prerequisites
Change responsibility to Sales Compensation Online Super User. (This is the JSP 
part of Oracle Sales Compensation)

Steps
Create a payrun for the salesperson.

1. Enter the pay period and pay group, or choose from list of values.

2. Select incentive type of Commission. 

3. Go to Payrun Summary. 

4. Assign payment date. 

5. Assign salespeople to pay to the payrun.

Withhold Commission on a Specific Sales Deal
You can change or adjust commission on a specific sales transaction in two ways. 
This is the first way:

1. In Payrun Summary, press Total. It takes you to Payrun Details

2. Select total amount. This brings you to Payment Transactions.

3. Check check box to hold payment for a particular transaction.
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4. Adjust the total amount manually in the right-hand column, labeled Payment 
Amount.

The second method to hold payment is to add the Hold Payment attribute to the 
salesperson. This will prevent any transactions the salesperson processes from 
being paid until the hold is lifted.

You can view all transactions of a salesperson. 

Steps
1. From Sales Compensation, select Task > Define Resources

2. Query the Salesperson and press ‘Resource Details’

3. Select the Compensation Tab. Check the Hold Payment check box and enter a 
Hold Reason code.

Account Generator
Expense and Liability Account information is supported by default at three levels:

■ REVENUE CLASS

■ PLAN ELEMENT

■ CLASSIFICATION

If the transaction level option is chosen then the following setup has to be done 
similar to the current classification Ruleset procedure:

Steps
1. Define the name of the ruleset.

2. Give a start and end date of this ruleset.

3. Select the type of Account Generator.

4. In the Navigator, right-click the Ruleset that you have just created and select 
Add new Child Rule.

5. The Rules window appears.

6. Assign a name to the rule that you are about to define.

7. Choose a revenue class from the list of values. Optionally select Expense & 
Liability account.

8. Enter the Expense and Liability Accounts from the list of values.
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9. In the Rule Attributes tab, choose a user column name from the list of values, 
choose the type of values from the drop-down list, and enter the value or values 
that apply.

10. Optionally, enter additional attributes for the rule.

11. Every attribute is assumed to be linked to other attributes with AND.

12. If you want any of the attributes to be related with OR, use the Build Expression 
tab to relate the first two attributes with AND or OR.

13. An additional value of Result1 appears in the first column and is added to the 
attribute list of values.

14. Continue to relate the remaining attributes. Use Result1 to relate a third 
attribute to the first two.

15. Save the rule.

16. The expression appears.

17. To add rules in the hierarchy of rules, position your cursor over the parent rule, 
right click, and choose New Rule. Repeat from step 2.

18. Return to the Ruleset Form for every ruleset that has new or changed rules and 
click Synchronize.

Guidelines
1Guidelines

The application checks to see what account generator level has been set. Based on 
this level, the appropriate Accounts Payable accounts will be associated to the line 
item. 

Levels
Revenue Class: Each revenue class will be assigned a specific liability and expense 
account. This option should be used if tracking expenses for each product is 
required.

Plan Element: Each plan element can be assigned a specific liability and expense 
account. This option should be used if all products assigned to the plan element will 
be assigned to the same expense and liability account.

Classification: An entire rule can be assigned a specific liability and expense 
account. 
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Payroll Integration
In this release, Oracle Sales Compensation is integrated with Oracle Payroll. Now, 
users can pay their resources through Oracle Payroll without modifying their 
existing environments. A user-defined mapping feature enables users to define 
what data they need to send from Sales Compensation to Payroll. This is 
accomplished by mapping plan elements in Sales Compensation to pay elements in 
Oracle Payroll.

A payroll in Oracle Payroll defines a group of employees who share the same 
frequency of processing and payment, defined by the payroll calendar in PER_
TIME_PERIODS.

You must define pay elements and input values in Payroll first. Then, before 
sending information to Payroll, perform the following steps in Sales Compensation:

1. Map Sales Compensation Plan Elements to the Pay Elements in Payroll

2. Map information from Sales Compensation to be passed as input values for the 
pay elements in Payroll

Pay Elements Mapping

Prerequisite
Using the System Parameters window, enable integration with Payroll. 

Steps
1. Click Payment tab, Setups subtab.

The Pay Elements Mapping window appears.

2. Select a Plan Element from the list of values in the Plan Element column. Use 
the search fields at the top of the window if needed.

3. In the Pay Element (Payroll) field, select the Pay Element to which you want to 
map the Plan Element. Use the search field above if needed. 

4. Enter a Start Date and End Date in the fields to the right.

5. Select the Remove icon or the Inactive Employees check box if desired.

6. Click Update.

7. If desired, click Restore before clicking Update to return the window to the 
previously saved version. 
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Guidelines
The mapping information is stored in the CN_QUOTA_PAY_ELEMENT_MAP 
table. The three-column table below shows examples of how the mapping is set up 
between Sales Compensation plan elements and Payroll pay elements, with the 
salesperson status indicated in the third column:

Pay Element Input Values Mapping
If a pay element in Payroll has been defined to have input values, then you can 
define a mapping in Sales Compensation that identifies which data columns in 
Sales Compensation tables map to the input value of a pay element. The following 
tables can be used to map Sales Compensation to Pay Element Input Values:

CN_COMMISSION_HEADERS

CN_COMMISSION_LINES

CN_PAYRUNS

CN_POSTING_DETAILS

CN_SALESREPS

This mapping is stored in the CN_PAY_ELEM_INPUTS table in Sales 
Compensation.

Steps
1. Click the Payment tab, subtab, and select Element Input Values from the Setup 

Steps cue card.

Plan Element (OSC) Pay Element (Payroll) Salesperson Status

01 Account Quota Commission Pay ACTIVE

01 Account Quota Commission Pay INACTIVE

Recoverable Payment Plan Commission Pay ACTIVE

Payment Plan Recovery Commission Pay ACTIVE

Q1 OCG Bonus Bonus Pay ACTIVE

Q1 OCG Bonus Bonus Pay INACTIVE

Education Commission Pay ACTIVE

Education Commission Pay INACTIVE
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2. Select a pay element from the list of values in the Pay Element 
field.

3. Enter a Start Date and End Date.

4. In the table, select Sales Compensation Table and Column values 
to map them to the values displayed in the Input Values (Payroll) 
column.

5. Click Update.

Reports
The following reports are available in this release:

Planning Reports

Quota Model Summary

Average Quota Summary

Overassign Quota Summary

Quota Range Summary

Overlay Summary

To-Be-Hired Summary

Transitional Salespeople

Compensation Plan Generation Status

Sales Role and Compensation Plan Mapping

Production Reports

Year To Date Summary

Quota Performance

Commission Statement

Commission Summary

Transaction Details

Compensation Group Hierarchy
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Unprocessed Transactions

Quota Model Summary
With this report, you can get a snapshot of:

■ A compensation group’s total quota and its constituents

■ A compensation group’s quota approval status by salesperson

■ The overassignment effect reverberating through lower levels of the 
organization hierarchy

You can see in one report the quota allocations to every resource or salesperson, 
including the manager of a selected compensation group. The quota is broken down 
by individual components that make up the total quota.  Additionally, the user can 
see the over assignment expressed in values as well as percentages between each 
level of the organization hierarchy.  These are represented by subtotals at the bottom 
of the report for each level of salespeople; for example, the total quota for 
salespeople at the bottom of the hierarchy (street level), the total quota for the 
immediate manager (first line manager) and the total quota for the manager of the 
first line manager.

Parameters

The search criteria will produce a list of Compensation Groups. User is required to 
select one Compensation Group.

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or 
%

Employee Number Search field No but the default is "All" or 
%

Compensation Group Search field No but the default is "All" or 
%

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s 
date
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Data
The first table of information 
:

The second and last table of information:

Column Title Description

Salesperson Name Lists salespeople in the Compensation Group selected

Employee Number Displays associated employee numbers

Role Displays associated roles

Role Start Date Displays the start date of each salesperson’s assigned role

Role End Date Displays the end date of each salesperson’s assigned role

Component 1 Name Displays the assigned quota against this user-defined 
Component

Component 2 Name Displays the assigned quota against this user-defined 
Component

Component 3 Name Displays the assigned quota against this user-defined 
Component

Total Quota Displays the total assigned quota for all Components for each 
role

Assigned Quota Displays the rounded figure of the total quota

Plan Status Displays the approval status of the Compensation Plan

Overlay Yes or No flag (see Concepts and Procedures for explanation of 
overlay)

Row Title Description

Total quota for second 
line manager

Displays column totals for all salespeople with Plan Level value 
of 2 (see Sales Role Details screen and Plan Level field)

Total quota for first line 
manager

Displays column totals for all salespeople with Plan Level value 
of 1

Total quota for street Displays column totals for all salespeople at the bottom of the 
hierarchy for this Compensation Group and with Plan Level 
value of 0 or null

Over assign from second 
line manager to first line 
manager

Displays the second line manager’s quota as a percentage of the 
first line manager’s quota
112 Oracle Sales Compensation Implementation Guide



Reports
Average Quota Summary 
With this report, you will know what the average quota value is by role for the 
selected compensation group. It is useful to know the average quota value for 
comparable roles in various compensation groups and organizations. In some 
companies, compensation groups are organized by sales territory. Therefore, it is 
possible with this report to compare the quota between comparable roles over 
various territories.

Additionally for reference, the planned sales figure to be delivered by the selected 
compensation group is shown by means of a summary table that displays the total 
quota, excluding overlay and a breakdown of total quota by role. (Refer to Concepts 
& Procedures for explanation on overlay.) Against each role, there is a headcount. In 
the next and subsequent tables for each role there is a list of salespeople and a 
simple average of the quota assigned by role.

Parameters

The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data
First table of information :

Over assign from first 
line manager to street

Displays the first line manager’s quota as a percentage of the 
street salespeople quota

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Row Title Description
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The last row displays the grand total.

Second and subsequent tables of information are listed by role or Compensation 
Plan :

The last row displays the total number of salespeople for the role and the simple 
mathematical average for each column.

Column Title Description

Sales Role Lists the roles available in the Compensation Group selected

Number of People Displays the total number of people of each assigned role

Component 1 Name Displays the total assigned quota against this user-defined 
Component by role

Component 2 Name Displays the total assigned quota against this user-defined 
Component by role

Component 3 Name Displays the total assigned quota against this user-defined 
Component by role

Total Quota Displays the total assigned quota for all Components for each 
role

Assigned Quota Displays the rounded figure of the total quota by role

Column Title Description

Name Lists the salespeople with the relevant role or Compensation 
Plan

Component 1 Name Displays the assigned quota against this user-defined 
Component for each salesperson

Component 2 Name Displays the assigned quota against this user-defined 
Component for each salesperson

Component 3 Name Displays the assigned quota against this user-defined 
Component for each salesperson

Total Quota Displays the total assigned quota for all Components for each 
salesperson

Assigned Quota Displays the rounded figure of the total quota for each 
salesperson
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Overassign Quota Summary 
You can see in one report what the over assignment value and percentage effect is 
on the immediate level of salespeople and the street level salespeople. This report 
only displays salespeople with manager roles. 

Parameters

The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data

Quota Range Summary 
This report allows you to scan the list for those salespeople who fall outside the 
range of minimum and maximum quota values predefined for each role. Contract 

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Name Lists the manager of the compensation group selected

Role Displays associated roles

Plan Start Date Displays the start date of each salesperson’s assigned plan

Plan End Date Displays the end date of each salesperson’s assigned plan

Assigned Quota Displays the rounded figure of the total quota assigned

Direct Over assign Displays the compensation group manager’s quota as a 
percentage of his/her directs’ total quota

Street Over assign Displays the compensation group manager’s quota as a 
percentage of street-level salespeople’s total quota
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Approvers can use this report as a means of rejecting compensation plans or 
contracts that have been submitted for their scrutiny. 

For each selected compensation group, the maximum and minimum quota range is 
displayed for each role. In addition, there is a column that shows how each 
salesperson’s assigned quota in the selected compensation group fared against the 
minimum quota set for the role.

Parameters

The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Employee Number Displays associated employee numbers

Name Lists salespeople in the compensation group selected

Sales Role Displays associated roles

Assigned Quota Displays the rounded figure of the total quota assigned

Quota Minimum Displays the role’s minimum quota as defined under the Sales 
Role Details screen

Quota Maximum Displays the role’s maximum quota as defined under the Sales 
Role Details screen

Percent of Minimum Displays each salesperson’s actual assigned quota as a 
percentage of each role’s quota minimum
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Overlay Summary 
This report lists all overlay salespeople, if any, who are members of the 
compensation group selected. (Refer to Concepts & Procedures for explanation on 
overlay.) This report is a concise display of overlay salespeople as distinct from 
previous reports where both overlay and nonoverlay salespeople are displayed 
together.

Parameters

The search criteria will produce a list of Compensation Groups. User is required to 
select one Compensation Group.

Data

To-Be-Hired Summary 
This report lists all salespeople who have not been hired as yet, in the selected 
compensation group. It is a concise means of listing vacancies and additional 
headcount requirements on one report.

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Salesperson Name Lists salespeople in the compensation group selected

Job Title Displays each salesperson’s job title as read from Oracle 
Resource Manager

Sales Role Displays associated roles

Assigned Quota Displays the rounded figure of the total quota assigned
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Parameters

The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data

Transitional Salespeople 
This report lists all salespeople who have not been allocated a role, in the selected 
compensation group. It is a means of identifying those salespeople who do not have 
a role for the next contract cycle.

Parameters

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Salesperson Name Lists vacancies in the compensation group selected

Compensation Group Lists the compensation group manager’s name

Sales Role Displays associated roles

Plan Start Date Displays the start date of each salesperson’s assigned plan

Plan End Date Displays the end date of each salesperson’s assigned plan

Assigned Quota Displays the rounded figure of the total quota assigned

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %
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The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data

Compensation Plan Generation Status 
This report lists the compensation plan activation status for all salespeople in the 
selected compensation group. The activation process is related to passing approved 
compensation plans from Sales Force Planning to commission processing (forms 
based part of this application). This report helps you to identify those compensation 
plans that have not been activated for commission processing and to take action to 
investigate its non-active status.

Parameters

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Employee Number Displays employee numbers of the salespeople in the selected 
compensation group

Name Lists salespeople in the compensation group selected

Manager Name Lists the compensation group manager’s name

Manager Number Displays the compensation group manager’s employee number

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Prompts Choices Mandatory
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The search criteria will produce a list of Compensation Groups and User is required 
to select one Compensation Group.

Data

Sales Role and Compensation Plan Mapping 
This report lists all sales roles and how each was mapped to job title(s) as read from 
Oracle Resource Manager, for each compensation group selected.

Parameters

Data
The first table of information:

Column Title Description

Employee Number Displays employee numbers of the salespeople in the selected 
compensation group

Name Lists salespeople in the compensation group selected

Compensation Group Lists the compensation group’s name

Role Displays associated roles

Plan Status Displays the approval status of the Compensation Plan

Reason Displays the reason for any incomplete status

Prompts Choices Mandatory

Salesperson Name Search field No but the default is "All" or %

Employee Number Search field No but the default is "All" or %

Compensation Group Search field No but the default is "All" or %

Organization List of Values No but the default is "Any"

Effective Date Calendar pick list No but the default is today’s date

Column Title Description

Role Displays all roles that satisfy the effective date search criteria

Compensation Plan Displays the name of each compensation plan
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Year to Date Summary
This report is an overview of a salesperson’s achievements, commission and bonus 
earnings and advances or draws. This report is accessible by default by the 
manager, salesperson and sales compensation online super user responsibilities. 

The figures are grouped by period and by plan element.  Super user can control 
which plan element appears as a quota or bonus category through the Quota Group 
checkbox on the Plan Element form. The pay out section is grouped by earnings 
type and by period.

Parameters

Data

Start Date Displays the beginning date of the compensation plan

End Date Displays the lapsed date of the compensation plan

Prompts Choices Mandatory

Salesperson Name/Number List of Values - Will contain 
both name and number

Yes

Salesperson Type List of Values

Sales Role List of Values Yes

Reporting Period List of Values Yes

Currency Type List of Values

Credit Type List of Values

Column Title Description

Commission Commission amount salesperson earned during the 
specified period

Bonus Bonus amount salesperson earned during the specified 
period

Other Manual commissions amount salesperson earned during 
the specified period

Column Title Description
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Quota Performance
This report is a snapshot of salespeople achievement and earnings. Achievements 
are shown against interval to date quota and annual quota. Earnings total are 
broken down by period to date and interval to date.

Parameters

Data

Advance Commission Advances that applied for the salesperson during the 
specified period

Total Compensation Total amount of compensation due to the salesperson

Gross Payment Gross Payment to the salesperson

Total Payments Total Payment to the salesperson

Beginning Advance Balance Beginning Advances balance for the salesperson

Current Advance Balance Current advances made to the salesperson

Recovery Amount Recovery amount applied for the period

Ending Advance Balance Ending Advance balance

Commission Pending Pending Commission Transactions

Bonus Pending Pending Bonus Transactions

Prompts Choices Mandatory

Analyst List of Values Yes (only for super user)

Period List of Values Yes

Credit Type List of Values Yes

Column Title Description

Name Salesperson Name

Employee Number Salesperson’s Employee Number

Cost Center Salesperson Cost Center

Column Title Description
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Commission Statement
This report shows transaction details broken down by period for a salesperson. It is 
configurable and for instructions on how to hide or show selected columns, go to 
Configuring reports section below.

Parameters

Charge to Cost Center Cost Center where commission will be charged

Analyst Analyst Name

Sales Role Salesperson Sales Role

Compensation Plan compensation plan name

Annual Quota annual quota assigned

Percent Annual Quota achievement expressed as a percentage of annual quota

YTD Quota Target Year to date quota

YTD Quota Credit Year to date sales credit

YTD Quota Earnings Year to date quota-based earnings

YTD Bonus Earnings Year to date bonus earned

YTD Total Earnings Year to date total earnings (quota-based earnings plus bonus 
earned)

PTD Quota Target Period to date quota

PTD Quota Credit Period to date sales credit

PTD Quota Earnings Period to date quota-based earnings

PTD Bonus Earnings Period to date bonus earned

PTD Total Earnings Period to date total earnings (quota-based earnings plus bonus)

Prompts Choices Mandatory

Salesperson Name List of Values Yes

Period List of Values Yes

Period Type List of Values Yes

Compensation Category List of Values

Column Title Description
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Data
This standard report lists the transactions a salesperson is eligible to receive 
commission for during a specified period.   The columns visible are controlled by 
the System Administrator.  Users can have up to 12 columns visible without having 
to scroll left or right.   Below is a sample of the available columns for this report.

Commission Summary
This report is a snapshot of salespeople achievement and earnings. Achievements 
are shown against interval to date quota and annual quota. Earnings total are 
broken down by period to date and interval to date.

This report is identical to the Quota Performance report except that there are 3 extra 
columns (on the far right) available through this report. This report is accessible 
through Sales Compensation Online Super User by default whereas the Quota 
Performance report is accessible by default to those users with Manager and 
Salesperson responsibilities.

Parameters

Column Title Description

Invoice Number Invoice Number

Invoice Date  Invoice Date

Order Date Order Date

Order Number Order Number

Commission Amount Commission Amount

Credit Receiver Credit Receiver

Prompts Choices Mandatory

Analyst List of Values Yes

Period List of Values Yes

Credit Type List of Values Yes
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Data

Transaction Details
This report shows transactional details of the specified salesperson and is used 
primarily by the salesperson and sales manager. It provides the details from the 

Column Title Description

Salesperson Name Salesperson Name

Salesperson Number Salesperson Number

Cost Center Salesperson Cost Center

Charge to Cost Center Cost Center where commission will be charged

Analyst Analyst Name

Sales Role Salesperson Sales Role

Compensation Plan Compensation Plan

Annual Quota Annual Quota

Percent of Annual Quota Achievement as a percentage of Quota

YTD Quota Target Year to date quota

YTD Quota Credit Year to date sales credit

YTD Quota Earnings Year to date quota-based earnings

YTD Bonus Earnings Year to date bonus earned

YTD Total Earnings Year to date total earnings (quota-based earnings plus bonus 
earned)

PTD Quota Target Period to date quota

PTD Quota Credit Period to date sales credit

PTD Quota Earnings Period to date quota-based earnings

PTD Bonus Earnings Period to date bonus earned

PTD Total Earnings Period to date total earnings (quota-based earnings plus 
bonus)

Begin Balance Beginning Balance of what is due to the salesperson

PTD Quota Earnings Period to date quota-based earnings

PTD Bonus Earnings Period to date bonus earned
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Year To Date Summary report.  The report can be run to show results of any 
specified period and by transaction status.

It is configurable and for instructions on how to hide or show selected columns, go 
to Configuring reports section below.

Parameters

Data
This standard report lists the transactions a salesperson is eligible to receive 
commission for during a specified period.   The columns visible are controlled by 
the System Administrator.  Users can have up to 12 columns visible without having 
to scroll left or right.   Below is a sample of the available columns for this report.

Prompts Choices Mandatory

Salesperson Name List of Values Yes

Order Number List of Values

Adjustment Status List of Values

Invoice Number List of Values

Process Date From List of Values

Process Date To List of Values

Transaction Type List of Values

Adjustment Date List of Values

Calculation Status List of Values

Column Title Description

Invoice Number Invoice Number

Invoice Date  Invoice Date

Order Date Order Date

Order Number Order Number

Commission Amount Commission Amount

Credit Receiver Credit Receiver
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Compensation Group Hierarchy
This report is useful not only for displaying compensation groups and the resources 
in each, but also for showing the roll up hierarchy of the groups in relation to each 
other. In the first column, the number indicates the level in the hierarchy of the 
compensation group. The Level 1 group is at the top of the hierarchy, and is also at 
the top of the report. Where there is a hyperlink, click the resource name to display 
a Year to Date Summary for that person.

Parameters

Data

Unprocessed Transactions
This report is a useful way for locating transactions by process status. Users have 
the option of running this report for any calculation status, load status and 
adjustment status for any specified salesperson, date, transaction type, order and 
invoice number.

This report is configurable and for instructions on how to hide or show selected 
columns, go to Configuring reports section below.

Parameters

Prompts Choices Mandatory

Effective Date List of Values Yes

Dimension Name List of Values Yes

Hierarchy Name List of Values

Column Title Description

Hierarchy Name Hierarchy Name

Node Name Children Nodes of the Hierarchy specified

Effective Dates Effective Dates

Prompts Choices Mandatory

Salesperson Name List of Values Yes
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Data
This standard report lists the transactions a salesperson is eligible to receive 
commission for during a specified period.   The columns visible are controlled by 
the System Administrator.  Users can have up to 12 columns visible without having 
to scroll left or right.   Below is a sample of the available columns for this report.

Order Number List of Values

Adjustment Status List of Values

Load Status List of Values

Invoice Number List of Values

Process Date From List of Values

Process Date To List of Values

Transaction Type List of Values

Adjustment Date List of Values

Calculation Status List of Values

Column Title Description

Invoice Number Invoice Number

Invoice Date  Invoice Date

Order Date Order Date

Order Number Order Number

Commission Amount Commission Amount

Credit Receiver Credit Receiver

Prompts Choices Mandatory
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Report Access by Responsibility
x indicates that the report is accessible with the corresponding default responsibility

Sales 
Force 
Planning 
Super User

Sales 
Force 
Planning 
Finance 
Manager

Sales 
Compensation 
Online Super 
User

Sales 
Compensation 
Manager

Sales 
Compensation 
Salesperson

Planning 
Reports

Quota Model 
Summary

x x

Average 
Quota 
Summary

x x

Overassign 
Quota 
Summary

x x

Quota Range 
Summary

x x

Overlay 
Summary

x x

To-Be-Hired 
Summary

x x

Transitional 
Salespeople

x x

Plan 
Generation 
Status

x

Role To Plan 
Mapping

x

Performance 
reports

Year-To-Date 
Summary

x x x
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Configuring Reports
Each JSP report that has been developed has a corresponding region in AK.  It is this 
information that determines what end users will have displayed on their screens in 
the form of the reports.  System Administrators can go into the AK Developer 
responsibility and configure the JSP reports.

NOTE:  JSP reports can share the same AK region.  By making any changes to the 
AK region, users will hide or show the column in all reports referencing the same 
AK region.

Prerequisites
System Administrator access privilege is required.

Quota 
Performance

x x x

Commission 
Statement

x x x

Operational 
Reports

Commission 
Summary

x

Transaction 
Details

x

Hierarchy x

Exception 
Report

Unprocessed 
Transactions

x

Sales 
Force 
Planning 
Super User

Sales 
Force 
Planning 
Finance 
Manager

Sales 
Compensation 
Online Super 
User

Sales 
Compensation 
Manager

Sales 
Compensation 
Salesperson
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Steps
1. Login as System Administrator

2. Select AK Developer responsibility

3. Select Define Regions

4. Query the specific JSP Name

5. Press Region Items button in the lower right hand corner

6. All the region information will appear on the screen.  To hide or show columns, 
the System Administrator will have to select or deselect the check box labeled 
’Node Display’.
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